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第一章：歡迎使用 EndNote 

EndNote 簡介 

 EndNote 是一個線上檢索工具 

EndNote 讓您非常簡易且直接地查詢線上書目資料庫書目（包含自各種不同

的線上服務或資料庫，匯入檢索結果資料檔），並協助您蒐集文獻至 EndNote

內。 

 EndNote 是一個參考文獻和圖像資料庫 

EndNote 針對您個人儲存的參考 Library 進行書目資料儲存、管理、查詢。您

可以組織像圖片、表格和方程式的影像資料，並能就 EndNote 書目管理軟體

儲存您的電子全文檔。 

 EndNote 是建立書目與草稿的軟體工具 

EndNote 可以透過 Cite While You Write TM 功能在 Microsoft Word 中編排引用、

圖表等格式。當您在撰寫文章之初稿中插入引用格式時，即隨插即用地建立

您的參考文獻與圖表清單。另外，透過 Microsoft Word 樣板，亦能指引您如

何正確地藉撰寫文章的手稿範本，來滿足您發表文章的需求。 

關於 EndNote 試用版和 EndNote 瀏覽器 

如果您使用的是 EndNote X3 試用版，就您開始啟用 EndNote 起算 30 天內，得使

用 EndNote 所有功能。經 30 天後，EndNote 試用版會變成只能瀏覽 EndNote 之

功能限制的瀏覽器(EndNote Viewer)。 

關於使用手冊 

這本手冊將為您簡介如何安裝及使用 EndNote：儲存參考資料和撰寫文章，讓您

快速瀏覽、了解 EndNote 重要功能與特色。 

客戶服務 

 EndNote 使用手冊和線上輔助說明 
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EndNote 使用手冊：於安裝完 EndNote 後，會在 EndNote 資料夾中內建一個

完整的 EndNote 使用手冊(PDF 檔)。在開始→程式集→EndNote→EndNote 

Manual，即開啟完整的手冊。 

EndNote 線上輔助說明：您可自 EndNote 程式的 Help 選單，點選 Contents

瀏覽不同主題說明。 

 客戶服務：與國外 Thomson Reuters 出版社直接聯繫 

(1) Sales Information 
Phone: (760) 438-5526 (country code is 01) 
Fax: (760) 438-5573 (country code is 01) 
Web/Email: http://www.endnote.com/encontact.asp 

(2) Customer Service (Orders, Billing, and Shipping) 
Phone: (800) 336-4474 (country code is 01) 
Fax: (215) 386-2911 (country code is 01) 
Web/Email: http://www.endnote.com/encontact.asp 

 客戶服務：與國內代理商碩睿資訊有限公司聯繫 

(1) 客戶服務 

電話：(02)8226-8587 

Email：services@customer-support.com.tw 

(2) 公司網站：http://www.sris.com.tw 

(3) 產品網站：http://www.isiuser.com 

 技術支援 

當您使用 EndNote 遭遇問題時可聯絡技術支援。當您連絡時，請清楚描述問

題和使用之 EndNote 版本、Windows 系統、Word 等版本。從 EndNote，點

Help 選單，選擇 About EndNote，即可了解目前使用 EndNote 的版本。 

與國外 Thomson Reuters 出版社直接聯繫 

(1) 透過Web/Email或電話聯絡，請見： 

http://www.endnote.com/encontact.asp 

(2) 適逢非上班時間與假日，請見： 

http://scientific.thomson.com/support/techsupport/hours/ 

與碩睿資訊有限公司聯繫 
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(1) 透過Web/Email或電話聯絡，請見： 

Email：services@customer-support.com.tw 

(2) 公司網站：http://www.sris.com.tw 

(3) 產品網站：http://www.isiuser.com 

 

 EndNote 網頁 

EndNote 官網(http://www.endnote.com)包含支援小工具、資料轉檔效益、與

EndNote 最新版本資訊。您也可在官網的 Support and Services 看到各種不同

版本之教育訓練文件、更新 styles、filters、connection files，以及其他相關

檔案。另外，您也可參考 EndNote 的 Help 選單，選擇”EndNote Program 

Updates”進行更新。 

 EndNote –討論區 

如果您想參加 EndNote 使用者的討論區，可到 EndNote 官網

(http://www.endnote.com)，點選 Support and Services 選項，將網頁下拉至

EndNote Discussion Forum、點選，即可連至討論區，並檢索、瀏覽相關議題，

或參與各許多相關 EndNote 的議題討論。 

EndNote X3 新功能 

在 EndNote X3 版，新增了下列功能： 

 新群組功能 

EndNote X3版將智慧群組(Smart Group)與自訂群組(Custom Group)整合在同

一群組底下，每個群組可再組成一個大群組(Group Sets)；讓您更方便透過群

組先組織所有參考書目，再藉大群組(Group Sets)組織您所有的群組（詳見

EndNote英文手冊第九章的”Using Groups”）。 

 Cite While You Write 支援 OpenOffice.org 之免費文書處理軟體 

有關 CWYW 已能支援 OpenOffice.org 之免費文書處理軟體，使用者可透過

OpenOffice.org Writer 查詢 EndNote 資料、引用文獻，並快速轉換為不同投

稿期刊格式；詳見 EndNote 英文手冊第十二章的”Cite While You Write with 

OpenOffice.org Writer。 

 建立各章節的參考文獻 

http://www.sris.com.tw/
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就 Word 文件當中的每一章節能建立個別之參考文獻書目，或統一匯整於整

份文件最後；請見英文手冊第十一章之”Creating Multiple Bibliographies in 

Single Document”或 EndNote 英文手冊第十七章。 

 鑑別多重引用文獻 

在 Microsoft Word 文件裡，被多重引用而群組在單一數字下的文獻，能以字

母區別，以利檢視；可見 EndNote 英文手冊第十一章之”Numbering 

Citations”。 

 藉 Find Full Text 來尋找電子全文 

於介面左邊新增 Find Full Text 群組，使用者透過 OpenURL 鏈結解析器與 proxy

伺服器得直接檢索、下載與自動夾帶電子全文檔(PDF)於既有之書目；請參

考 EndNote 英文手冊第六章”Finding Full Text for a Reference”。 

 使儲存夾帶的檔案更容易成複本 

請見 EndNote 英文手冊第五章”Saving a Copy of an Attached File”。 

 其他更新 

已擴增、更新書目之 Output styles(約 3,700 種)，於 import filters 與 connection 

files 皆各預設存有 100 個最常用的 filters，讓點選使用更便捷；於 Connection 

files 可在介面上直接設「我的最愛」，累計最多 500 個 connection files。 

 新增 EndNote 與微軟系統的相容性 

EndNote 已能支援微軟 64 位元版本的系統。 
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第一章：EndNote 安裝 

安裝 EndNote 前 

程式需求 

 系統需求： 

Windows XP，with Service Pack 3 (32 位元或 64 位元版本) 

Windows Vista  (32 位元或 64 位元版本) 

 硬體需求：個人 PC 需在 Pentium 450 MHz 以上、256 MB 以上的記憶體、至

少 180 MB 以上的硬碟可用空間。 

 如果需使用 Online Search 功能檢索線上網站或資料庫的功能，也需要有安

裝支援網路連結的瀏覽器。 

文書處理軟體 

至 2009 年 6 月為止，Windows 系統的 EndNote 可支援： 

 支援 Microsoft Word 2003 或 2007 版本的文書處理軟體。 

 支援自 OpenOffice.org 文書處理軟(Writer)所建的 Open Document 

Format(ODT)格式檔案。 

 支援其他文書處理軟體（包含 Microsoft Word, WordPerfect, OpenOffice.org 

Writer, StarOffice,與 WordPad）所建之 RTF 檔。 

 

Microsoft Word： 

安裝 EndNote 的 Cite While You Write 功能會結合在 Microsoft Word 底下。於 Word 

2003 使用 EndNote，此工具列在 Word「工具」選單。Word 2007 即直接呈現一

個 Cite While You Write 欄位於介面上。您可透過「Cite While You Write 功能」在

Word 中引用書目、編排引用格式，包含格式、不格式或再格式化您的 Word 文

件。在您安裝 EndNote 時就會自動嵌入 EndNote 在您的 Word 文書處理軟體中，

所以請務必安裝 EndNote 時，理應先安裝好您的 Microsof Word，才不會產生錯

誤問題。 

 

OpenOffice.org Writer： 

EndNote 已能支援第 3 版 OpenOffice.org 文書處理軟體之使用，並且主動產生一

個 EndNote 選單。您也可在 OpenOffice.org 的文書處理軟體上藉 Cite While You 

Write 功能引用文獻、產生參考文獻，套用不同的書目格式、不格式或再格式化
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您文件之書目內容。為了讓 EndNote 能適當地應用於您 OpenOffice.org 文書處理

軟體，安裝 EndNote 前應先安裝好 OpenOffice.org 第 3 版之文書處理軟體(以下簡

稱 Writer)；且在安裝時，務必關閉所有 OpenOffice.org 應用軟體（含 OpenOffice.org

的快速開啟功能(Quickstarter)，位於右下角之功能列上的 Quickstarter 圖示，才能

正常安裝）。 

 

RTF 和 ODT 文件： 

若非 Word 2003、Word 2007 以及 OpenOffice.org 第 3 版的文書處理軟體，請就

撰寫好的文章（含文章中的文獻引用），儲存成 RTF 檔（亦即 ODT 文件以外的檔

案格式），然後透過 EndNote 格式化文件功能，自您 ODT 和 RTF 檔就引用與參考

書目套用書目格式（格式化）。詳見 EndNote 英文手冊第十三章。 

 

於手持行動裝置使用 EndNote  

若您的電腦有安裝軟體可同步使用Palm OS®、Windows Mobile®的Pocket PC®等手

持裝置， EndNote安裝程式會同時詢問您是否要安裝EndNote於您手持行動裝置

上。 

 

欲執行EndNote在Palm Operating System上需要下列硬體： 

 手持裝置 

 Palm Operating System 4.x 或更新版本 

 支援 HotSync 操作的 Serial 或 USB 傳輸 

 16 MB 記憶體（至少 8MB） 

 

欲執行 EndNote 在 Windows Mobile 裝置上需要下列硬體： 

 像 Pocket PC 的 Windows Mobile 手持裝置 

 Windows Mobile 操作系統第 5 版以上 

 支援 ActiveSync 操作的 Serial 或 USB 傳輸 

 16 MB 記憶體 

 

關於如何在手持裝置 Palm OS 使用 EndNote，請開啟 EndNotet 程式，點 Help 選

單中的 Contents 選項。或至”Palm OS Handhelds”、”Windows Mobile Device (Pocket 

PC)”兩書，翻閱 Help 單元。 
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安裝 EndNote 

安裝步驟 

1. 首先確認您登入電腦為具權限管理或具安裝程式的使用者身份，確認防毒軟

體、Microsoft Word 或 OpenOffice.org 等沒有任何正在執行程式，例如

OpenOffice.org 的快速啟動(Quickstarter)會影響安裝程式，需先關閉

Quickstarter 之執行(請依圖示點 Exit 離開)。 

2. 從貴單位網頁上下載 EndNote X3 壓縮程式。 

 

3. 解壓縮該程式後出現兩個檔案：ENX3Inst.msi 和License.dat(合法授權安裝檔)，

請將這兩個解壓縮出來的檔案放在同一資料夾，以利安裝順利： 

 
 

4. 按下 ENX3Inst.msi 開始進行安裝，安裝前請先關閉 Word，待出現”Welcome to 

the EndNote X3 Installation”，按下”Next >” 

 
 

5. 出現”EndNote X3 Volume License Version”，按下”Accept> 
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6. 出現”Read Me Information”，按下”Next >” 
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7. 出現” EndNote for Palm OS Read Me” 畫面，按下”Next >” 

 
 

8. 出現” EndNote for Windows Mobile Read Me”，按下”Next >” 
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9. 出現”Select Installation Type”，請按”Next >” (建議點選 Typical 安裝) 

 
 

10. 出現”Select Destination”，請更改您安裝儲存路徑，或按”Next>” 採預設安裝 
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11. 出現”Select Default Citation Manager”，請按”Next>” 

 
 

12. 出現”Ready to Install the Application”，請點”Next>” 
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13. 出現”Updating System”和”Current Operation”，請稍待片刻 

 
 

 
 
 

14. 出現”EndNote X3 has been successfully installed”畫面，按下”Finish”完成安裝。 
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客製化安裝選項 

雖然我們建議您選擇選項 Typical 安裝 EndNote，但 Custom 選項可適用於硬碟空

間較低，或您需重新安裝某些 EndNote 構成元件，如新增額外之內容檔，Output 

Styles、Import filters 或 Connection Files 等。 

 

執行客製化安裝 

1. 請見第 10 頁依照前述安裝步驟。 

2. 至第 13 頁”Select Installation Type”時，在安裝對話框中點 Custom 安裝選項。 

3. 當您看到對話方框標題為”Select Features”，請依其下方的選單，勾選哪些您

要安裝或不安裝的選項。 

 

 

已安裝完 EndNote X3 後，安裝 EndNote 構成元件 

1. 請先依管理者或安裝程式管理者之使用權限登入作業系統。 

2. 啟動安裝執行程式；或至 Windows 開始選單，點「控制台」，選擇新增或移

除程式＞點 EndNote X3，按「變更」。 
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3. 出現”Application Maintenance”對話框，請點”Modify”安裝選項。 

 
 
 

4. 出現下圖”Select Features”對話框，可依閱讀各選項功能與特色，決定哪

一”Features”要選或不選，按”Next>” 
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選擇元件項目 

您可依上圖畫面主要幾個 EndNote 分類元件點選、安裝，這些元件包括： 

1. EndNote Application 
 EndNote Program 
 Sample Files 
 EndNote Help 
 PDF Manual 

2. Word Templates/Add-ins: 
 Templates for Microsoft Word 
 Cite While You Write for  Microsoft Word 

3. Additional Styles 

額外其他的 Styles 格式依種類群組、呈現。 

4. Additional Connections 

其他的 Connections files 可以直接從線上資料庫或網站取得，他們會依資訊服

務提供單位進行群組、分類。 

5. Additional Filters 

其他的 Filters 亦是依資訊服務提供單位群組、分類。 

6. Spelling Dictionaries 

EndNote 所提供的拼字檢查字典功能。 

7. EndNote for Palm OS ®與 Windows Mobile 

當欲在 Palm 作業系統或 Windows Mobile 操作系統使用 EndNote，可點此選
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項進行安裝。 

5. 出現”Ready to Modify the Application”對話框，請按”Next>”，進入系統安裝畫

面；請稍待安裝畫面完成即可。 

 
 

從舊版 EndNote 升級安裝 

在您開始安裝前，如果您不想被重新安裝的檔案覆蓋任何客製化之 Styles、Import 

Filters、Connection Files，請先備份；在安裝 EndNote X3 前，強烈建議先移除任

何舊版的 EndNote 版本，如何移除請見”Uninstalling EndNote”單元。 

於有關如何升級，例如安裝一個新的 EndNote X3 版，請見 EndNote installation

單元（預設路徑在 C:\Program Files\EndNote X3 資料夾）。 

備份或取代檔案 

如果安裝時發現安裝資料夾中有舊版 EndNote，它將提醒並給於予您兩個選項。

如果您將繼續安裝 EndNote X3，安裝過程中會移除舊的 EndNote 應用與 Word 支

援檔。您應從舊版 EndNote 中選擇您需要的 Styles、Filters、Connection Files。但

不管選擇哪個選項，您的 Library 不會被刪掉；也不會有任何非 EndNote 的檔案

在 EndNote 資料夾中。 

 

 備份舊有檔案 
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EndNote 提供完整更新的 Style、Filter、Connection Files 安裝。但是若您想保

留舊的任何有修改過之檔以用在 EndNote X3，您即可選擇「Backup older files」

選項。選擇後 EndNote 會在 EndNote 資料夾中建立一個 Backup 資料夾，並

複製所有舊版 EndNote 的 Style、Filter、Connection Files 於此。在安裝完

EndNote 後，您須移動要使用的 Style、Filter、Connection Files 至 EndNote X3

的 Style、Filter、Connection Files 資料夾中。 

 移除舊有檔案 

若您選擇「Remove older files」此項目，安裝程式將會取代所有舊版 EndNote

中之 Style、Filter、Connection Files，安裝成 EndNote X3 版本。所以，如果

您想保留客製化之 Style、Filter、Connection Files，請不要選擇此項目，以免

格式檔案被覆蓋。 

 

開啟和轉換舊有 EndNote Libraries 

EndNote X3 能自動轉換和開啟 EndNote 8 版本以後的 Library。 

 

轉換舊有 EndNote Library 

1. 開啟 EndNote 

2. 從 File→Open→Open Library 

3. 開啟檔案對話框選擇舊有的 Library，點選開啟。 

EndNote 會提醒選擇的 Library 是在舊版 EndNote 建立的，請確認是否真要進

行版本轉換。 

4. 點選 OK 轉換舊有 Library，進行新的 Library 命名和存檔。轉換功能會從

EndNote 8 以後的舊版本轉換，並自舊的 Library 複製一個新 Library 到

EndNote X3。 

注意：一旦您已經自 EndNote X3 開啟和使用 Library 後，則該 Library 只能用在

EndNote X 及 X 以後的版本。 

使用舊 Style、Filter、Connection Files 

EndNote X3 可以使用從 EndNote 4.01～X3 版所建立客製化的 Styles、Filters、

Connection Files。一旦您在 EndNote X3 中編輯過這些檔案並存檔，這些檔案就將

自動轉換成最新版本，並於 EndNote 8 之後的版本開啟。 

檢查安裝 

確認 EndNote 
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從開始→程式集→EndNote→EndNote Program。開啟 EndNote 程式後，會出現您

是否要開啟一個 EndNote web 帳號（或整合既有的 EndNote web 帳號）。接下來，

出現建立一個新的 Library 對話框；您可選擇建立或打開一個 EndNote Library，或

選擇 Cancel、Close 按鈕。請點選 Help 選單的 About 選項，檢查 EndNote 上的版

本序號。經確認完畢，直接就出現的版本視窗點一下，即可關閉版本畫面。  

確認 Cite While You Write 的安裝 

要檢查Cite While You Write是否安裝正確，請開啟Word或OpenOffice.org Writer。

在 Word 2003，點選工具選單您將會看到 EndNote X3 工具選項。 

 
 

在 Word 2007 您則可看到 EndNote 標籤與其下選項功能。 

 
 

在 OpenOffice.org Writer，您得直接看到一個 EndNote X3 選單功能。 
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原則上若安裝了 EndNote 後又重新安裝（更新）Word 文書處理軟體，則會看不

到 Cite While You Write 這個功能列；若 Word 或 OpenOffice.org Writer 看不到

CWYW 功能列出現，請先關掉相關 Microsoft Office 或 OpenOffice.org 系列的應用

軟體（含 QuickStarter）；然後在有系統管理或安裝程式權限下，點「開始」→「控

制台」→「新增或移除程式」→選擇「EndNote X3」然後按「變更」→選擇「修

復」、「下一步」進行功能修復動作。 

自動更新檔案 

當有新增程式功能時，即可透過設定自動更新 EndNote X3 軟體；相關設定如下： 

1. 開啟網路連線 

2. 從 EndNote 程式中→Help→EndNote Program Updates 

選取後會出現如下圖的安裝精靈，請依照步驟更新安裝即可。 
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注意：您也可以從 EndNote 官方網站 http://www.endnote.com 安裝最新檔案。 

移除 EndNote 

建議在移除 EndNote 安裝前，請先備份您的 Library 與任何特別設定的客製化檔。 

 

移除 Palm OS 與 Word 2007 的設定 

因 Palm OS 與 Word 2007 皆嵌在 EndNote 程式內，是故移除 EndNote 時亦會一併

移除 Palm OS 與 Word 2007 的設定。但相關 Palm OS 與 Word 2007 可針對特定使

用者帳號進行移除設定，相關設定如下： 

1. 從開始→所有程式→EndNote→Configure EndNote 或請至檔案總管

→C:\Program Files\EndNote X3→快速點兩下”Configure EndNote.exe”一檔 

2. 選擇”Remove all EndNote components for me”，點”Next>” 

3. 請依畫面指示，繼續進行移除 EndNote 安裝 

 

 

移除 EndNote 

請點至控制台→新增移除程式→EndNote X3→選擇移除，即可移除 EndNote X3 程

式。 

 

或請直接放入 EndNote 安裝光碟，點「Setup.exe」；至出現”Application Maintenance”

對話框後，選擇移除(Remove)並點選”Next>”等即可。 

http://www.endnote.com/
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第二章：EndNote Library 介紹 

本章節包含基本的操作 EndNote。您將學到： 

 開啟 EndNote 和開啟 EndNote Library 

 排序參考文獻 

 在 EndNote Library 選擇、開啟、關閉 EndNote Library 

 儲存參考文獻至 Custom 群組中 

 離開 EndNote 程式 

啟用 EndNote  

開始啟用 EndNote以及開啟 Sample library 

1. 從開始→程式集→ EndNote→ EndNote Program。第一次使用時，會出

現”Getting Started with EndNote對話指引視窗，供您選擇。 

 

注意： 如果設定預設Library自動開啟，則會直接開啟Library而不是上面這個對

話框。若發生此狀況，可關掉Library，至File選單→Open→Open Library進行設

定。 

2. 請點圖示“Open an existing EndNote library” 

3. 在檔案對話方框中，開啟一EndNote內建的reference library 
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 請用搜尋至清單中尋找EndNote X3/Examples資料夾。 

 或點選C:\磁碟→點選Program Files資料夾→EndNote X3資料夾→點

選”Examples”捷徑，然後開啟。 

 在開啟”Examples”畫面底下，請點選Sample_Library_X3.enlx，會解壓縮出” 

Sample_Library_X3”Library與” Sample_Library_X3.Data資料夾”，系統直接開

啟EndNote reference library目錄下的Sample_Library.enl範本檔案。 

 
 

EndNote Library 視窗介紹 

Sample Library時，您會在EndNote Library視窗介面，看到視窗包含三個部份，如

下所示。 

the compressed library 

the uncompressed library 
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1. 參考文獻清單視窗 

呈現參考文獻清單區塊，具多個欄位；預設第一欄是以迴紋針顯示該筆參考

文獻書目是否有附加檔案。接著為第一作者的姓(Author)、年代(Year)、標題

(Title)、期刊名稱(或第二標題)、參考書目類型(Reference Type)、網址(URL)和

最後更新日期(Last Updated)。 

2. 群組視窗 

視窗左方呈現參考資料之不同群組分群，以方便您直接查找參考文獻。 

3. Tab視窗 

EndNote Library右下方的Tab視窗可以Preview預覽每筆書目資料內容和書目

格式；點Search分頁進行EndNote Library書目查詢或線上資料庫之書目查找。 

 

有關呈現這些參考書目，您可利用下拉捲軸進行不同參考書目瀏覽，或點Page 

Down、Page Up、Home、End等鍵分頁瀏覽；並可至EndNote 的Edit>Preferences

變更您希望呈現之字型、大小。 

 

預覽參考文獻 

您可以透過Tab視窗之Preview區塊，看到您點選之參考書目資料內容。 

1. 如果在EndNote Library視窗中沒有看到Tab視窗，第一個步驟請點選Show Tab 

Pane開啟預覽視窗 

2. 本範例，請點「Bats: biology, behavior, and folklore」這筆參考書目，我們在預

可自行調整欄位至方便瀏覽的適合寬度 
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覽視窗中即可看現行對這筆書目設定而呈現之書目格式（output style）。

EndNote的output style是依不同期刊或其他出版商所建立的（或經這些期刊出

版商所要求的特定格式）；這個Style決定列印、輸出、預覽和建立參考文獻清

單時呈現之樣式。 

3. 如欲選擇不同格式，可從工具列的下拉選單中選擇輸出格式；例如選擇

Numbered格式。 

 
 

預覽視窗中只會顯示一筆參考文獻；如果選擇多筆參考文獻，也只會呈現第一

筆選取之文獻；當選擇不同書目格式，即改變其在預覽視窗中呈現之格式。 

 

點選Show Tab Pane出現預覽視窗後，Show Tab Pane按鈕會變成Hide Tab Pane；

若不要預覽視窗，可點選Hide Tab Pane，隱藏預覽視窗。 

Show/ Hide  

Tab Pane 按鈕 

Tab預覽視窗 

群組視窗 

參考文獻清單視窗 
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參考文獻排序 

參考文獻可以簡單的點選欄位標題作排序（如依作者、年代、標題排序）。排序

步驟如下： 

1. 點一下「Author」欄（作者），改變當下作者的排序方式，從依照字母遞增到

遞減排序。 

 

注意：這個例子呈現包含中文、日文字元。EndNote使用Unicode編碼特殊字元，

所以資料可以簡易地在平台、程式和語言中轉換。如果您看到亂碼，請將EndNote

改成Unicode字型顯示即可。 

 

2. 點一下年代(Year)標題欄，視窗中的參考文獻將依年代遞增排序。再點一下年

代的標題欄，視窗中的參考文獻則改為依年代遞減排序。 

3. 點選作者，視窗中的參考文獻則重新再會依作者名稱(字母順序)排序。 

選擇和開啟一筆參考文獻 

經點選欲開啟的參考書目，可分別透過滑鼠點選、鍵盤鍵入(Enter鍵)、直接點

選要查找的欄位（例如作者），鍵入要查找的前幾個字母（作者名稱的前幾個

字母），即會跳至符合該作者名稱字母開頭之書目上等，多元之開啟書目資料

方式。 
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快速找到和呈現參考文獻 

1. 當直接鍵入”arg”字母即可找到作者為 Argus 的參考書目，經點選該筆參

考後，您可瀏覽、編輯、複製、剪下、刪除選取的該筆書目。 

 

2. 就點選的書目，直接按鍵盤 Enter 鍵或滑鼠左鍵快點兩下，即可開啟、進

入編輯畫面。 

 

3. 開啟參考文獻後，會出現該筆參考書目之編輯視窗，可在此看到完整著錄

資料。 
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4. 視窗上方的標題列，出現”Argus, 1993 #34” 是EndNote用於Library查找這筆

引用文獻的系統紀錄碼，諸如在Word中被引用的作者是誰、哪一年以及引

用編號。 

5. 在瀏覽參考文獻時，可以利用滑鼠下拉捲軸、上移，或是利用TAB鍵往前，

利用SHIFT+TAB鍵往後。 

6. 點Show Empty Fields/Hide Empty Fields鈕顯示參考書目的所有欄位，或隱藏

沒有著錄內容的空白欄位。 

關閉參考文獻 

1. 點選視窗右上角的 (Close），即可關閉參考文獻視窗。 

2. 或從 File 選單選擇 Close Reference (或快速鍵CTRL+W指令)直接關閉參考

文獻視窗。 

3. EndNote會自動儲存您對該筆參考文獻所做的改變。 

儲存參考文獻到群組中 

在 EndNote Library 左方的視窗為群組區塊，並對應右方視窗來呈現該群組下所儲

存的參考文獻。在一個新 EndNote Library 中，預設有「All References」（Library

內所有的文獻資料）、「Unfield」（還未歸在哪一群組下的書目資料）、「Trash」（自

被 Library 刪除，但還未永久刪除清空之資料）三個群組；如下圖所示。 

展開或隱藏參考文

獻中空白欄位 

為關閉按鈕 

標題列 
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在這三個固定常在的群組下方，可建立匯整所有小群組之大群組(Group sets)項目；

大群組下一共可組織最多 500 個個人群組(custom groups)與智慧群組(smart 

groups)項目。 

 

所謂 Custom group，是指經個人意志所設的群組分類；而 Smart group 指基於檢

索策略，而自動整合、產生之群組。 

參考範例 Library（Sample Library），可看到呈現的數個個人群組項目；點「Bats」

大群組，即可看到其下分的小群組，點小群組名稱，可看到各包含的書目。 

 

  
 

再點 All References 群組名稱，即可見到 Library 內所有參考書目。 

 

建立個人群組和加入參考文獻 

1. 點在 Paleontology 大群組的位置，所建的新群組即建在此大群組下。 

2. 或至 Groups 選單→Greate Group（或在 Paleontology 大群組的位置直接按滑

鼠右鍵，自隨點呈現之選單中點 Create Group）。在群組中新建的群組名稱

會呈現 New Group 預設字樣並反白，可直接輸入要建立的群組名稱。 

3. 例如打”Extinction” 為群組名稱，然後按下 Enter 或點介面參考文獻清單區域

等即儲存。目前，新建之群組，還未儲存任何參考文獻，故對應的參考文獻

清單區域是空白。 

4. 請點至 All References 群組，就所有顯示之參考文獻，找作者名稱為 Argus

與 Billoski 的各第一篇文獻；對非排在一起的書目，可以 Ctrl 鍵分別點選。 

5. 利用拖曳功能將反白的這兩篇文獻拖曳到 Extinction 群組下（或從 Group 選

單→Add References To→Extinction 加入）。 

6. 點 Extinction 群組即可在右邊視窗看到加入到該群組下的這兩筆參考文獻。 

大群組名稱 

個人群組名稱 

智慧群組名稱 

可依群組名稱前的圖示

識別 
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7. 若要回到看見所有參考文獻，請點 All Reference。 

 

移動群組位置 

1. 點 Extinction 群組名稱，持續壓住滑鼠左鍵然後進行拖曳，移到要更改群組分

類的位置。 

2. 拖曳它到 Bats 這個大群組分類下，直接放開壓住的滑鼠左鍵即可。 

 

刪除一個群組 

1. 點 Extinction 群組名稱，按滑鼠右鍵，自展開的選單中選 Delete Group。 

2. 或點群組名稱，至 Groups 選單下的”Delete Group“選項，亦是刪除該群組。 

您可善用右鍵所出現的快捷選單功能；此刪除功能只會刪除群組，不會刪除在該

群組內的 EndNote Library 參考文獻。 
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相關章節 

有關本章之相關章節，可瀏覽 EndNote.PDF manual 全英文手冊之第四章資訊 

 在英文手冊第四章”The EndNote Library”可瀏覽關於改變 Library 視窗呈現方

式。 

 在英文手冊第八章”Sorting the Library”可學到更多在 Library 排序書目資料之

方式。 

 在英文手冊第九章”Using Groups”可學到更多關於新增、管理群組說明。 

點欲刪除群組名稱右鍵，

在出現快捷功能選單→選

Delete Group 
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第三章：設定 EndNote 偏好設定 

在本章節將為您介紹： 

 EndNote Preferences 設定與呈現 

 設定每次開啟 EndNote 時，開啟預設指定的 Library 

 改變呈現字型 

開啟 Sample Library 以見範例說明 

開啟 EndNote 並打開 Sample Library（Sample_Library_X3.enl）；請見英文手冊第

27 頁說明。 

進入 EndNote Preferences 

從 EndNote 程式點選 Edit→Preferences 

設定預設 Library (Default Library) 

您可設定每次執行 EndNote 程式後，自動開啟某個 Library。這是現行您有喜愛

或希望指定某個 Library 的一個好用設定。設定步驟如下： 

1. 從視窗最上方點選 Edit → Preferences 

2. 跳出 EndNote Preferences 視窗，在視窗左邊的選項中選擇「Libraries」。 

3. 在 When EndNote starts 下拉選單，請選”Open the specified libraries” 

4. 點 Add Open Libraries，此時 Sample Library (Sample_Library.enl)會出現在中

間方框中。 

5. 點選套用儲存改變。 

6. 點選確定後，系統會自動儲存並離開 EndNote Preferences 偏好設定視窗。 
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改變 Library 呈現字型 

選擇在 Library 視窗和參考文獻視窗呈現不同字型。 

1. 從視窗最上方點選 Edit → Preferences。 

2. 在 EndNote Preferences 視窗左邊，點 Display Fonts 選項。 

 設定「Library」字型，改變 Library 視窗中呈現參考文獻清單之字型與大

小。 

 設定「General」字型，改變 EndNote 內文字形和大小，例如參考書目

或 Style 視窗)。經設定「General」字型，會改變於預覽視窗之字型大小，

與 EndNote 輸出、列印或複製參考書目的字體。 

 設定「Label」字型決定參考書目編輯視窗欄位標題大小（如下圖所示）。  

 設定「Search」字型決定使用者在檢索欄位中輸入之字體大小。 
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3. 改變字體與大小之設定，請在 Display Fonts 選項下，分別點選欲更改設定之

分頁標籤，例如上述「Library」、「General」、「Label」、「Search」，然後按”Change 

Font“按鈕。 

4. 在字型清單中選擇欲改變的字型、字型樣式與大小，選「確定」進行改變儲

存。最後，再按一次「確定」離開 Preferences 對話框。 

此處為改「Label」字體為

20pt 大小的呈現結果 
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相關章節 

相關章節請參考 EndNote.PDF 英文手冊： 

 可在英文手冊第四章瀏覽更多關於改變 Library 視窗之呈現方式。 

 在英文手冊第二十章可瀏覽更多 Preferences 設定方式。 
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第四章：輸入參考文獻 

在此章節您將學到 

 在Library中輸入參考文獻 

 在參考文獻中插入圖片和檔案 

在這個單元，您可以學習如何使用參考文獻、在參考文獻中插入圖片、搜尋參考

文獻以及列印參考文獻。您也將學習如何創造和列印包含注釋之參考書目。 

開啟 Sample Library 

請開始執行 EndNote 程式，並開啟 Sample Library 檔案，以利參考本章說明。詳

見”Start EndNote”英文手冊第 27 頁。 

新增參考文獻 

利用下列方法可新增參考文獻： 

 在Reference視窗中直接鍵入參考文獻。 

 透過EndNote線上查詢書目資料庫文獻；又如英文手冊第五章”Searching an 

Online Database”說明。 

 自線上書目資料庫查得參考書目，並下載成純文字檔匯入EndNote；詳如第

六章”Importing Reference Data into EndNote”介紹。 

手動建立新 Reference 

1. 選擇工具列中的 References 選單→ New Reference，跳出 New Reference 的

空白視窗。新參考文獻視窗預設為 Journal Article 類型，您可從參考文獻下

拉選單中選擇您所想要的參考文獻類型(Reference Type)。 
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2. 本範例之文獻類型為”書籍”，即應從 Reference Type 下拉選單中選”Book”。 

  

本範例從輸入作者名稱開始建立此筆書目資料： 

3. 輸入作者姓名 

（1） 作者姓名有兩種呈現方式 

點參考文獻類型為：Book 

(書籍)後，其提供輸入書目

的欄位也會相對改變 

請先設好要建的文獻類型

(點下拉選單) 
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 名在前，姓在後，如：Tiberius Rex 

 姓在前，名在後，如：Rex, Tiberius 

（2） 輸入第一作者，以 Tiberius Rex 為例 

輸入 Tiberius Rex 時，EndNote 採用「term lists」功能，會主動對應 Library

是否有已建之人名，提供相似名稱建議；由於 Sample Library 中並未收錄

這個作者資料，故介面會以紅色呈現”Tiberius Rex”人名。在儲存的這筆參

考文獻後，EndNote 會將您所鍵入之作者加到 Sample Library 的作者清單

(Term List)，加入後作者名稱會變成黑色。 

（3） 輸入第二作者，以 Morre, Nicole 為例 

一位作者一列。當您輸入 Morre, Nicole 時，由於在 Sample Library 中已經

收錄該作者名字，故輸入 Morr 字母(還未鍵完)時，EndNote 即會自動列出

對應 Morre 開頭的「Morre, Nicole」完整人名（即可直接按 Enter 採用

EndNote 所建議的對應名稱）。 

 

（4） 輸入第三作者，例如以 de Young, John Robert, Jr.為例 

第一個逗點前的為作者的”姓”，第二個逗點擺名字，於 Jr.這種接辭尾請

放在最後面，讓 EndNote 知道 Jr.不是作者名稱的一部份。當輸入此作名

名稱時，出現 De 開頭建議的名稱出來，因該名稱並不是您要輸入的人

名，且 de 變 De 開頭，請按清除鍵(Baskspace)，即會更正為 de。 

（5） 第四位作者以團體作者（corporate author name）為例 

像團體作者，University of California,, Berkeley，得多加一個逗點表示沒

有”名稱”(first name)了，以供 EndNote 識別這不是一般個人作者名稱，

而是團體名稱。 

4. 輸入年代及其它資料 

（1） 用滑鼠移動到下一欄位，或使用 TAB 鍵移到 Year 年代一欄，輸入 2006 

（2） 您可以使用滑鼠移動到要編輯的欄位，用 TAB 鍵往下移或 Shift+TAB 鍵

往前移動，繼續在其他欄位中輸入資料，各欄位資料如下；沒有要輸入

資料的欄位即保持空白： 

Title: Impacts of meteorites on Earth 
City: New York 
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Publisher: Blackcourt Press 
Number of Pages: 100 
Abstract: The impact of a meteorite hitting earth millions of years ago may 

have led to the extinction of some marine life. 

 

 

5. 不論哪一文獻類型，皆固定有 Figure、Chart（Table）和夾帶照片、物件執

類型檔案欄位。 

（1） 當欲夾帶檔案，請跳至 File Attachments 欄位→點 References 選單

→File Attachments→Attach File→跳至一個選擇檔案的對話方塊（在

此以 EndNote 資料夾內的 pdf 檔為例） 

（2） 請點至 C:\Program Files\EndNote X3，然後點選 EndNote.pdf 

（3） 請注意要鉤選該對話方塊下方之”Copy this file to the default file 

attachment folder and create a relative link.以確保您所選的這個檔案

會被 EndNote 儲存一個檔案複本，以利這個檔案能隨著您儲存的

EndNote Library 檔移動。 

（4） 經選了 EndNote.pdf 檔後，點選「開啟」即夾檔在 EndNote 書目資

料上（每一筆書目資料最多可夾帶到 45 個檔案）。 

 

由於這本書沒有Series Title 和 

Series Editor兩項資料，所以這兩個

欄位就保持空白。 
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就快點兩下 pdf 檔案圖示，即可開啟 EndNote.pdf 檔。 

6. 當您完成所有欄位編輯後，關閉編輯視窗，EndNote 即自動儲存資料；並看

到它存在 Library 清單中。 

 

就關閉編輯的參考書目，經瀏覽後，可針對該筆書目再快速點兩下開啟，回到編

輯視窗檢視其所有著錄內容。按視窗關閉鈕「Close」，即又回到瀏覽參考書目的

清單視窗。在清單書目前面，最前方的標題欄中出現 圖示，即可知道該筆參

考書目的 File Attachments 欄位有插入檔案。 

在參考書目清單視窗，可點一下作者欄位進行所有書目排序（依作者字母順序排

序）。 

在參考文獻中加入圖片 

若文獻有相關圖表，希望能附加在該筆書目上，但每一筆參考文獻只能夾帶一

個圖片檔。但一個圖片檔案和一個物件檔案之有下列差別，如下界定。 

 

以下為圖片檔案之延伸解釋： 

 BMP  Windows Bitmap 
 GIF   Graphics Interchange Format 
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 JPEG  JPEG File Interchange Format 
 PNG  Portable Network Graphics 
 TIFF  Tag Image File Format 

 

您也可以插入物件檔案，所謂之物件檔，包括： 

 Audio files (WAV, MP3) 
 Microsoft Access files 
 Microsoft Excel files 
 Microsoft Power Point files 
 Microsoft Project files 
 Microsoft Visio files 
 Microsoft Word files 
 Multimedia files (MOV, QuickTime) 
 Technical drawing files 
 Text files (TXT, RTF, HTML) 
 

以下為插入圖片之相關步驟： 

1. 使用“在參考文獻中加入檔案”模式，在建立的參考文獻中插入圖片。 

2. 選擇 References 選單→Figure→Attach Figure。 

 
 
 
 
 
 
 
 
 
 

3. 在

出現的 Attach Figure 視窗中 

（1） 點選 Choose File 開啟 C:\Program Files\EndNote X3\Examples 資料夾 

（2） 選擇 Feather2.BMP 檔，並開啟。 

（3） 在 Reference 中可以看到插入的 Feather2.BMP 圖檔。 

4. 在 Caption 一欄輸入 Cockatiel Crest Feathering 作為圖片說明（附加之圖片可

被引用在 Microsoft Word 中）。 

5. 關閉視窗後，系統會自動儲存資料並且回到 Sample Library 視窗。 
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在參考文獻中插入圖表檔案 

1. 選擇上方工具列的 References → New Reference，出現 New Reference 視窗 

2. 在 Reference Type 的下拉選單中選擇 Chart or Table 

3. 在年代、標題等欄位中輸入以下資料： 

Created By: Milkirk, Marie 
Year: 2002 
Title: Hominid Timeline 
Image Source Program: Microsoft Excel 
Date: May 9 
Keywords: Evolution 

Hominids 
Timelines 

Abstract：This article discusses the evolution of bird feathers from reptilian 

scales. 

4. 在 EndNote 視窗最上方選擇 References → Figure→Attach Figure 

5. 此時會跳出 Attach Figure 視窗 

（4） 點選 Choose File 開啟 C:\Program Files\EndNote X3\Examples 資料夾 

（5） 選擇 Hominid Evolution.xls 並開啟該檔案，之後點選 OK 插入檔案 

（6） 在 Reference 中可看到剛剛所插入的 Hominid Evolution.xls 這 Excel 檔 

6. 在 Caption 欄位中輸入 Hominid Timeline 作為此檔說明。 
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7. 當關閉視窗後，系統會自動幫您儲存資料並且回到 Sample Library 視窗。 

 

最後，若欲離開 EndNote，請至 File 選單點 Exit 離開、關閉 EndNote 程式。 

 

 

相關章節 

詳細本章介紹，請參考下列： 

 有關建立 Library 資訊，可參考英文手冊第四章”The EndNote Library”。 

 更多詳細在 Library 建立參考書目、插入圖片，可見英文手冊第五章”Entering 

and Editing References”。 
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第五章：搜尋線上資料庫 

在EndNote進行線上資料庫搜尋參考書目的查詢方式，就跟我們在EndNote Library

查找書目資料一樣簡易；而且查得之檢索結果，可直接匯入EndNote Library中。 

 

本章您將學到下列基本步驟： 

 連結線上資料庫 

 檢索資料庫，下載參考書目至EndNote Library 

 查找並夾帶參考書目全文檔 

 

進行本章節前，請連上網路。 

關於PubMed資料庫 

本章節，您將連到美國National Library of Medicine提供之線上免費使用MEDLINE

版本資料庫，其名稱叫PubMed。 

開啟Sample Library 

請執行 EndNote程式，並開啟 Sample Library 範例檔。請見英文手冊”Start EndNote”

第 27 頁說明。 

切換操作視窗 

至 Library 視窗左邊區塊，可選擇下列三種呈現模式，分別是：Integrated Library & 

Online Search Mode、Local Library Mode 或 Online Search Mode。 

這三種呈現模式中，主要是兩種使用 EndNote 模組概念： 

1. 將所有EndNote群組、指令和在線上資料庫直接下載檢索結果到 Library內等，

為整合 EndNote 的全功能模式。 

2. 使用 EndNote 時，只在沒有顯示 Online Groups 群組的 Local Library 模式操作，

直至要查找線上資料庫、下載書目資料時，才跳到 Online Search Mode 視窗

之使用模式。 

 

於 Integrated Library & Online Search Mode、Local Library Mode 或 Online Search 

Mode，分別是整合 EndNote 所有功能，以及將 Local Library 與 Online Search 

Mode 群組功能分開之設計，這三個不同呈現模式之切換，請依個人習慣，

點左邊群組區塊上方之三個工具按鈕切換。 
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選擇連線資料庫 

1. 從EndNote視窗上方工具列中，選擇Tools → Online Search，自出現的一個標題

為Choose A Connection File視窗，選擇線上資料庫名稱（同Groups中的Online 

Search區塊，點”more”呈現資料庫清單）。在Online Search選單會將您選擇過

的線上資料庫記憶在左邊Online Search群組下，以便使用者下次直接點選、

查詢；使用者亦可客製化常查詢之資料庫清單。 

  

Online Search Mode 

Local Library Mode 

點選 More 或是 Less Info 開啟或是

隱藏關於此 Connection 說明 

Integrated Library & 

Online Search Mode 
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注意：視窗將顯示所有可連結之資料庫清單，您可使用Quick Search功能快速查

到，以助您更快找到要連結的資料庫，或透過分類瀏覽、篩選。 

 

2. 選PubMed後，點Choose。接著會在EndNote Library視窗下方，跳出Online 

Search -PubMed MEDLINE at PubMed (NLM)”檢索視窗，表示您已連上這個資料

庫。 

 

注意：若您先前已建了預設檢索條件，開啟檢索視窗時，會顯示已設的檢索策略。

若某一欄位標示為斜體字，那表示資料庫中無此一檢索欄位。 

查詢 PubMed 資料庫 

1. 以本範例為例，從查詢視窗欄位下拉選單選”MeSH Terms”，在後方空白欄

位中輸入”fossil”；對照選單請選擇Contains。 

 

 

 
 

2. 點”Search”進行查詢。EndNote會將檢索條件傳至PubMed，待出現查得筆數

之檢索結果視窗。 

 

3. 若查得筆數覺得太大，可按「Cancel」回檢索畫面，下更精確的檢索條件，

對照選單 
布林邏輯選單 

欄位下拉選單 

檢索詞 
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如在第二查詢欄位輸入”trilobite”，並從下拉選單中選擇Any Field欄位、對照

下拉選單中選Contains，最後並選擇布林邏輯AND來結合第一個與第二個檢

索條件。 

 

4. 點Search；EndNote傳送檢索條件到PubMed資料庫，待跳出查詢結果視窗。 

 

5. 可依需求，更改欲下載筆數。以本例，在檢索結果視窗改下載1到10筆；經

點”OK”後，即會看到自PubMed線上資料庫下載只10筆之書目。下載後，會

在All References群組，和連PubMed資料庫的暫存群組中出現這10筆書目。 

 

檢查參考文獻 

可仔細閱讀取得的參考書目，確認這些參考文獻是否都符合需求。您亦可個別開
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啟每篇文獻，或利用Preview快速瀏覽標籤檢視。 

1. 自參考文獻清單點選書目。 

2. 在Tab視窗點選Preview標籤，預覽點選的書目。 

3. 在EndNote工具列，從Edit選單→Output style→選擇Show All Fields，即可在

Preview視窗瀏覽書目格式與內容。 

 

刪除參考文獻 

因為從線上資料庫抓下來的書目是直接匯入 EndNote Library 來，故對不想保留的

參考書目請刪除。刪除方式如下： 

1. 在PubMed群組，選擇不想要的參考文獻兩篇。 

2. 從References選單→選Move References to Trash，選擇的兩篇文獻就會從

Library中移到Trash群組。 

3. 若已確認要刪除這兩篇文獻，即可點選Trash群組，然後從References選單

→Empty Trash。 

4. 點選”確定”，即會完全刪除這兩篇文獻。 

5. 點選All References群組即可回到完整參考文獻清單。若要更改其他書目格式

呈現，請到EndNote工具列，下拉Output Style選單選擇，並於Show all Fields

改以簡列書目格式預覽。 
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若您再欲至PubMed查詢其他資料，請點選PubMed群組，輸入其他檢索策略，

點Search。在Confirm Online Search視窗中會再呈現有符合查詢條件的筆數；於

視窗若勾選”Clear currently displayed results before retrieving records”選項，能清

除之前暫存在PubMed群組中的資料，但注意此功能只是清除PubMed群組中的

文獻，不會影響原本查得、已存之Library書目。 

 

為參考文獻尋找電子全文檔 

有些線上資料庫不僅只有書目資訊，還附電子全文檔；可藉下列步驟，找到電

子全文並夾帶檔案自該對應的書目記錄上。 

1. 請在所有參考文獻的畫面點任一篇文獻，然後自鍵盤鍵入”Kelly”，直接跳到

作者名稱是Kelly開頭的文獻。 

2. 請點這筆書目和其上一筆作者為”Knell”書目。 

3. 至參考書目選單(References)，點Find Full Text→Find Full Text…。此時會出現

一個宣告著作財權產的對話方塊。 

4. 點”OK”後，EndNote即會進行線上電子全文查找。 

正在查找電子全文的過程，左邊群組下方之Find Full Text區塊會出現一

個”Searching”群組，顯示正在線上搜尋全文中。此線上搜尋全文是一個背景

處理模式的功能，待查找全文過程，您仍可一邊使用EndNote軟體功能、直

接操作介面。 

當自線上找完電子全文檔，Searching Group即會消失，並依Found PDF、Found 

URL、或Not found三個類目顯示檢索結果。 

請按右鍵，或

References>Empty Trash 清除 
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下圖範例指找到全文電子PDF檔一筆，以及一筆可找到全文的URL網址。 

 

經有找到全文的書目，即直接在參考書目清單前面顯示一個已夾帶檔案的

迴文針圖示。 

 

相關章節 

本章節更詳細之內容，可參考第六章英文手冊： 

 第六章介紹如何建立參考文獻查詢與文獻取得。 

 可至”Selecting a Connection File”單元了解有哪些Connection files能線上查

詢。 

 當建立連結遇到問題時，可見英文手冊”Troubleshooting Connections附錄” 

的詳細說明。 

 英文手冊第十九章”Connection Files”提供更多關於建立、編輯Connection 

Files之設定。 

正在查找 Full Text 時，會多

一個 Searching 群組分項 
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第六章：匯入參考文獻資料至 EndNote 

第五章已介紹大家如何從線上資料庫直接取得參考文獻，但不是所有資料庫都有

支援此功能。如果您從線上資料庫、大學館藏目錄或是光碟資料庫儲存、下載純

文字檔，則亦可透過 EndNote 的 import filters 匯入檢索結果純文字檔。 

 

此章節您將學習到： 

 以 Tag 輸出格式下載資料 

 選擇 Import Filter 和匯資料至 EndNote 中 

開啟 Sample Library 

請執行 EndNote 程式，並開啟 Sample Library 檔（請見英文手冊第 27 頁說明）。 

查詢資料庫和儲存參考文獻 

有些查詢資料庫，所存成的檢索結果純文字檔，並未能就EndNote格式指引書目

欄位，例如在PubMed介面查得之檢索結果，其純文字檔存的引用格式即是一例。 

Am J Med Genet A. 2005 Mar 9; [Epub ahead of print] 

Reconstructing the behaviors of extinct species: An excursion into comparative 
Sampleneurology. 

Rogers SW.  

Salt Lake City VA-Geriatrics Research, 

Education and Clinical Center and Department of Neurobiology and Anatomy, 
University of Utah School of Medicine, Salt Lake City, Utah. 

How can the behavior of an extinct species be reconstructed-say a dinosaur 
such as Allosaurus? Despite the relatively abundant fossilized remains of this and 
other dinosaurs, the incompleteness of the fossil record has permitted room for 
considerable 

speculation, mythology, and perhaps a bit of unsettling reflection on what factors 
contributed to the eventual fate of these remarkably successful animals. 
(continued) 

(c) 2005 Wiley-Liss, Inc. 

PMID: 15759265 [PubMed - as supplied by publisher] 

 

類似這種狀況，EndNote並無法明確辨識每筆書目之Title、Address、Abstract等欄

位等是哪些書目資訊。 

為了要能夠對應此筆純文字檔上的書目資訊，每筆書目內容都須使用一致的tag

格式來對應到EndNote欄位。通常資料庫廠商會提供數種對應格式，請將參考文
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獻存成Tag格式純文字檔，以利EndNote匯入。本手冊以已從PubMed資料庫下載

為MEDLINE格式之參考文獻為例。 

PMID- 15759265 

OWN - NLM 

STAT- Publisher 

DA  - 20050310 

PUBM- Print-Electronic 

IS  - 1552-4825 

DP  - 2005 Mar 9 

TI  - Reconstructing the behaviors of extinct species: An excursion into comparative 
Sampleneurology. 

AB  - How can the behavior of an extinct species be reconstructed-say a dinosaur 
such as Allosaurus? Despite the relatively abundant fossilized remains of this 
and other dinosaurs, the incompleteness of the fossil record has permitted 
room for considerable speculation, mythology, and perhaps a bit of unsettling 
reflection on what factors contributed to the eventual fate of these 
remarkably successful animals. Among the speculations is how these 
'bigger-than-life' creatures behaved, a topic that itself can attain equal 
diversity and grandeur. With recent advancements in measuring the 
relatedness of living organisms, how genetics contribute to brain 
development and how this relates to behavior, combined with the availability 
of newly discovered high quality fossils and imaging methods to exploit their 
secrets, novel insights into how extinct creatures such as Allosaurus 
intermingled with its many relatives over 100 million years ago are beginning 
to emerge. (c) 2005 Wiley-Liss, Inc. 

AD  - Salt Lake City VA-Geriatrics Research, Education and Clinical Center and 
Department of Neurobiology and Anatomy, University of Utah School of 
Medicine, Salt Lake City, Utah. 

AU  - Rogers SW 

LA  - ENG 

PT  - JOURNAL ARTICLE 

DEP - 20050309 

TA  - Am J Med Genet A 

JID - 101235741 

EDAT- 2005/03/11 09:00 

MHDA- 2005/03/11 09:00 

AID - 10.1002/ajmg.a.30538 [doi] 

PST - aheadofprint 

SO  - Am J Med Genet A 2005 Mar 9;. 
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若未像以上每個欄位Tag皆對應EndNote欄位，即可能無法正確全部匯入書目到

EndNote。 

選擇正確的 Import Filter 和匯入資料至 EndNote 

一旦您以Tag格式儲存了書目資料，您還是需要選擇適當的EndNote Filter來把資

料匯入。EndNote中已內建了針對不同特殊資訊提供者所設計的Tag，共有數百筆

個Filters格式可供您選擇。 

匯入PubMed範例純文字檔至Sample Library 

1. 從File選單點選Import選項。 

2. 點選Choose File按鈕，出現瀏覽檔案對話框。 

 

3. 瀏覽EndNote X3\ Example資料夾，點選pubmed_result.txt檔案 

4. 在從Import Option清單中選擇Other Filters，呈現所有在EndNote Filters資料夾

中內建的Filters。 
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5. 可在Choose An Import Filter清單上先點任一Filter，之後在鍵盤鍵入”PubMed”，

即直接跳到”PubMed”的 Filter上。 

注意：目前，EndNote在視窗預列了100個最常被使用的filters，但EndNote本

身共有數百個filters可供選擇。 
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6. 反白PubMed(NLM) Filter選項，點選Choose。 

7. 回到Import畫面，於Duplicates欄位選擇Import All（EndNote預設重複書目篩選，

為比對Author、Year、Title和Reference Type之四個欄位；您也可至EndNote的

Preferences選項修改希望加以比對的欄位）。 

Text Translation選擇No Translation（一般若書目資料語言不同，而有字元差異，

例如中文字類型資料vs英文類型資料，即在對應上需加以轉譯）。 

8. 點選Import，進行資料匯入。當匯入完成後，Library視窗會呈現新匯入之參考

文獻。 

注意：在Groups區塊的All References群組，會多一個Imported References群組，

表示剛剛您所匯入的書目資料。 

9. 要重新呈現所有在Library中的參考文獻，請在Reference選單中→點選Show All 
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References即可叫出所有參考文獻。 

 

 
 

輸出格式全覽和匯入的 filter 選項 

下表提供一些針對不同資訊提供者建議使用之輸出格式。請依此清單下載適合的

Tag格式、選擇適當的Import Filter。目前這些資訊出版皆是正確的，若未來有所

變更，請需與資訊提供者聯繫，或參照EndNote官方網站http://www.endnote.com

所更新之資訊。 

資訊提供者 建議下載格式 匯入選項 

AARP AgeLine 
(http://research.aarp. 
ageline/home.html) 

There is no method for downloading data from 
this database. Instead, save the results screen as 
a plain text file with your web browser’s Save 
command. The resulting text 
file contains tags which are preceded by 18 
spaces. 

Ageline (AARP) filter   

http://www.endnote.com/
http://www.endnote.com/
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資訊提供者 建議下載格式 匯入選項 

ACM Digital Library 
(Association for Computing 
Machinery)   

Users with subscription access to this website can 
save multiple records to a BINDER. Once saved, 
you can export the records in an EndNote format. 
Non-subscribers can download one record at a 
time:   
 1. Create a search.   
 2. Click on an article.   
 3. Scroll half-way down the page and select 
EndNote under Display Formats.   
Limitations:   
Since only plain text files can be imported into 
EndNote, you cannot import images, graphics, 
etc. Before importing, you may need to edit the 
file to insert a comma after corporate author 
names. Otherwise, EndNote will not be able to 
distinguish corporate authors from personal 
authors.   

EndNote Import   

CAS SciFinder Save references in the “Tagged Format” (*.txt) SciFinder (CAS) filter 

CSA (formerly Cambridge 
Scientific Abstracts)   

From the CSA search results screen, click 
Save/Print/Email. On the “Save/Print/ 
Email”screen, select: Record Format: Full Record  
Save File Format: PC   
Click Save. Your Web browser asks where to save 
the file. If your Web browser lets you save in 
different file formats, make sure you save as 
a“Text Only”(*.txt) file.   

Various filters for 
CSA databases are 
provided in the 
EndNote Filters 
folder.   

Dialog 

Set your communication software's option to 
capture text. Use Dialog's Format 5 with "tag" 
appended to the TYPE command --type 
"s1/5/1-20 tag".  
You must download data in Format 5. If Format 5 
is not available, try the“full”format, which is 
sometimes the same as Format 5. For questions 
concerning Dialog’s many formats, please contact 

Various Dialog filters 
are provided in the 
EndNote Filters 
folder.   
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資訊提供者 建議下載格式 匯入選項 

Dialog's tech support. 

DIMDI   
Use the DLOAD command with report D1 (e.g. 
DLOAD REPORT=D1). 

Various DIMDI filters 
are provided in the 
EndNote Filters 
folder.   

EBSCOhost   

After adding your selected references to your 
folder, click “View Folder”or“Folder has items”to 
see its contents.  
On the Folder Content page, click Export. On the  
Export Manager page, select “Generic 
bibliographic management software” to save a 
file to disk. Click Save. 

Various EBSCO filters 
are provided in the 
EndNote Filters 
folder.   

EDINA   

Use the“Name”format, where data is tagged with 
words such as“Author”rather than“AU.”Because 
there are so many different formats used for 
source data, you may need to manually edit 
source data after importing. 
EndNote cannot parse author names that are not 
clearly delimited, such as “S Hughes B Reynolds S 
A Bell & C Gardner.”You will need to manually edit 
author names.  

Various EDINA filters 
are available in the 
EndNote Filters 
folder.   
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資訊提供者 建議下載格式 匯入選項 

Emerald   

Display the marked list, click “display for 
download (ASCII),” and then save as a plain text 
file.   
The filter provided works for these Emerald 
databases:   
Emerald Management Reviews at 
http://www.emeraldinsight.com/revs/   
Computer Abstracts International Database at 
http://www.emeraldinsight.com/caid  
International Civil Engineering Abstracts at 
http://www.emeraldinsight.com/icea/   
Computer & Communications Security Abstracts 
at http://www.emeraldinsight.com/ccsa/   
Current Awareness Abstracts at 
http://www.emeraldinsight.com/caa/  
Limitations:   
Page numbers are separated by a hyphen with 
spaces on either side of it. You will need to 
manually remove the spaces after importing.   

Emerald filter   

InfoTrac (Gale)   

From the E-Mail Delivery panel at the bottom of 
the marked list window, restrict the contents 
to“citation;”do not choose“full article.” 
Limitations:   
Records often have extraneous information in the 
title field, which must be removed manually after 
importing.   

InfoTrac (GALE) filter   

INIST   

1. Click the Enregistrer button. 
2. Select the records you wish to download.  
3. Under “Quels champs?” choose "Tous les 

champs."  
4. Under“Incluez”choose "Numéro de notice et 

nom de la base de données" and "Libellés 
abrégés."  

5. Click the Sauvegarde de notices button.   

Various INIST filters 
are provided in the 
EndNote Filters 
folder.   

 INNOPAC    Save references in the “EndNote”format.    EndNote Import   
Knowledge Finder   Place document in the Save file, and select the Various Knowledge 
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資訊提供者 建議下載格式 匯入選項 

document. Choose Export Selected Documents 
from the File menu.   

Finder filters are 
provided in the 
EndNote Filters 
folder.   

Medscape   

After selecting the desired records and adding 
them to your clipboard, click the Save or Email 
Clipboard link. Save or email your clipboard in PC 
or Mac MEDLARS format as a plain text (*.txt) file.   

MEDLINE 
(Medscape)  filter   

NERAC   Save your file as plain text (*.txt).   NERAC   

OCLC FirstSearch   

1. Mark the records you wish to download. 
2. In the navigation pane, click Export. 
3. Click the radio button next to “The marked 

records” or “A range of records.” 
4. Click the radio button next to “EndNote.” 
5. Click Export and save to a Text file. 

Various OCLC filters 
are provided in the 
EndNote Filters 
folder. 

Ovid   

1. After selecting the references you wish to 
download, click Results Manager.  

2. Choose the following options:  
Fields: Complete Reference  
Citation Format: Reprint/Medlars (or Direct 
Export, if available) 

3. Click the Save button. Save the file as plain 
text (*.txt).   

The appropriate Ovid 
filter will be selected 
automatically when 
using Direct Export 
option. If you are 
using Ovid's multiple 
database searching, 
you must select the 
Direct Export citation 
format.   
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資訊提供者 建議下載格式 匯入選項 

ProQuest   

1. Select the desired references and then click 
the“My Research Summary”tab.  

2. Click the“Documents and Bibliography”tab.  
3. Choose“Export,”then either “Export directly 

to ProCite, EndNote or Reference 
Manager,”or“Download in a format 
compatible with ProCite, EndNote, Reference 
Manager and RefWorks.”If you choose the 
former, make sure your data is displayed in a 
tagged format before saving as a text file.   

 ProQuest filter   

PsycINFO  

http://www.apa.org 
After marking the records you wish to download, 
choose Full PsycINFO Record then click the 
Display Marked Records button. Select the text, 
then copy and paste it into a text editor, saving 
the file as plain text (*.txt).   

Use the PsycINFO 
(APA) filter.   

PubMed   

1. From the drop-down list next 
to“Display,”choose MEDLINE.  

2. From the“Send to”menu, choose File and 
save the file as a plain text file (*.txt).  

Note that the PMID will transfer to the Accession 
Number field in EndNote. 

PubMed (NLM) filter   

SilverPlatter WebSPIRS   

1. Once you've obtained your search results, 
click Save.  

2. Select the following“Save Records” options:  
Which fields?: All fields   
Include: Record number and database name   
Field labels: Short labels.   

3. Click the Save Records button. 
4. Use your Web browser to save the page as 

"Text Only" (do not save in HTML format).   

Various SilverPlatter 
filters are provided in 
the EndNote Filters 
folder.   
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資訊提供者 建議下載格式 匯入選項 

STN   
Set your communication software’s options to 
capture text to a file. Type the command“Display 
All”.   

Various STN filters 
are provided in the 
EndNote Filters 
folder.   

UnCover (Ingenta)   
Using your email software, save references 
emailed to you as a "Plain Text" or "Text Only" 
file.   

UnCover (INGENTA)   

VHL (Virtual Health Library)   

1. After selecting the desired references, scroll 
to the bottom of the page and click “Your 
collection”(or“Su selleccíon”).  

2. Cancel the print dialog, and then save the 
screen as a plain text file.  

Various VHL filters 
are provided in the 
EndNote Filters 
folder.   

Web of Knowledge 
Web of Science   

Display your marked references. Then, look under 
Output Records and select the option to output 
Full Records. Next, click Save to EndNote, RefMan, 
ProCite to have the references exported directly 
to EndNote. You may also choose Save to File to 
save the references to a text file and import them 
into EndNote.   

ISI-CE filter 

Wilson   

1. Click Print Email Save. 
2. Click Export to Bibliographic Software. 
3. Choose The EndNote Filter and click Export. 
4. Save to a text file. 

WilsonWeb filter 

WorldCat 
(OCLC FirstSearch) 

1. Mark those references to be saved and click 
Export. 
2. Choose Text File. 
3. Click Export. 

WorldCat (OCLC) 
filter 

 

從網頁直接輸出 

某些網站會提供一個下載按鈕，只要您點選了正確的import filter，就可直接將檢

索結果匯至EndNote中。請先打開要匯入的EndNote Library。這邊所謂”直接匯入”

或”直接下載(”direct export”、”direct download”)，是指已經不用額外將參考文獻

存成一個文字檔、選擇filter才能匯入EndNote的意思。 

像下表提供的清單，就是可直接輸出參考文獻並匯入EndNote的系統平台。而更

詳細之列表，可參考英文手冊附錄D。當然，下列清單會持續增加，所以也請與
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資訊提供者確認最新資訊。 

ALEPH Los Alamos National Laboratory 

American Psychological Association, 
PsycInfo Online 

MicroPatent 

Bibliotech.dk Nature 

BioMedCentral Nerac 

BioOne NISC 

Blackwell Synergy OCLC 

BMJ OhioLink 

Buffalo University OVID 

CABI-Direct OVID SilverPlatter 

Canadian Journal of Communication Oxford Press Journals 

CCLR Pacific Northwest Labs 

Delphion Patent Cafe 

EBSCO PILOTS 

EI Engineering PNAS Online 

Elsevier ProQuest 

EMBASE RLG 

ERIC Science Magazine 

ESDS Government Scopus 

Google Scholar St. John of God, Ireland 

HAPI Stanford University's Highwire Press 

IEEE Telemed 

JAMA Thieme 

JISC Web of Science 

JSTOR WebFeat 

Karger Publishing WilsonWeb 

 

 

相關章節 

關於本章更詳細之介紹，請參考： 

 英文手冊第七章”Importing Reference Data into EndNote”，有更多關於匯入選

項和從其他書目軟體程式匯入參考文獻之說明。 

 英文手冊第十八章”Filters”，介紹如何建立或修改Filter，以符合下載之參考

文獻能正確對應到EndNote欄位。 

 參見英文手冊附錄D之”Direct Export Formats and Imort Formats”，有列從不同

線上系統匯入參考文獻資料的詳細說明。 
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第七章：查詢 EndNote Library 與存成 Smart Group 

這個章節將引導您學習： 

 自參考文獻的子群組查找EndNote Library文獻 

 自檢索策略建立smart group 

開啟Sample Library 

若還未執行 EndNote，請開啟 EndNote 程式，並打開 Sample Library 檔案（請見

英文手冊第 27 頁說明）。 

查找參考文獻 

假設您想從Sample Library建一個2000年到2008年、相關extinction方面的參考文獻

清單。 

1. 請先確認All Reference群組中的所有參考文獻都已呈現在Library視窗中。 

2. 請到頁面下方的Tab視窗，點選Search標籤。 

3. 一般在Search標籤會記憶著您上次有輸入過的檢索策略，若要清除，可點選

Options按鈕，選擇Restore Default。 

 

4. 請在第一個下拉選單點選”Any Field”，指定EndNote進行所有欄位查詢；在第

二個下拉選單點選”Contains”（指EndNote查找時，找出任一欄位中有包含該

查詢詞彙之意思）。 

5. 在後方第一行空白欄位輸入檢索詞彙 ”extinct”。 

 

6. 請選擇查詢年份2000到2008年。 

自第一欄下拉選單選限定查找Year，對照欄位選”Is greater than or equal to”，

然後在空白欄位輸入2000。 

7. 若查詢頁面未看到第三列欄位，請點選 按鈕新增一行。 
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8. 同第六點步驟，一樣限定查詢Year欄位，對照下拉選單選”Is less than or equal 

to”，然後空白欄位輸入2008。 

請注意在每一個查詢欄位最前端都有And、Or、Not布林邏輯的選單功能。請

都選擇And條件。應查詢視窗會呈現如下畫面圖示： 

 

 
 

此查詢將會找到所有參考文獻中2000年到2008年間出版之包含”extinct”的

文獻。 

 

注意： 

以下兩個勾選框分別是指： 

《Match Case》：鈎此選項將限制您檢索詞彙”extinct”皆為小寫字母，如果在

句子開頭找到大寫或是所有都是大寫字母，EndNote將不查找之。 

《Match Words》：鈎此選項將限制檢索到完全符合”extinct”的詞彙，不使用

切截功能，所以像詞彙”extinction”字眼的文獻不會找出來。 

 

9. 點選Search按鈕開始查詢；呈現檢索結果會直接呈現於上方的參考文獻視

窗。 

注意：隨著查到檢索結束，左邊Group視窗會出現個”Search Results”的群組，

呈現了這次查到的4筆書目；此群組為暫存模式，伴隨每次檢索行為才出現，

並會主動替換掉您上次檢索的檢索結果；當您關掉Library，此群組即自動消

失。 

檢索項目 欄位選單 

對照選單 布林

邏輯 
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建立智慧群組(Smart Group) 

一般就所要查找某個主題類別之文獻資料，可能會希望能持續蒐集一陣子，而會

陸續追蹤的情況；在這個前題，您可就已查得之書目，自行建立一個個人群組

(Custom Group)，並就已鍵檔在Library內的參考書目直接拖曳、歸類到個人群組

中。然而，若您藉用智慧群組(Smart Group)的功能，即可自動更新同樣檢索條件

的書目資料。 

使用檢索策略並建立一個智慧群組 

1. 在上例中，Search畫面仍維持在剛剛所下的檢索條件，此時，可點

Options→Covert to Smart Group；隨後，您即會看到在Paleontology大群組下，

新增了一個Smart Group。 

 

2. 請就新增之Smart Group更名為”Extinct”，做為這個檢索策略之識別標題，並

按Enter。 

3. 若還未更新到Smart Group群組名稱，其Smart Group名稱會預稱為「Converted 

Search」，即請點著這個群組名稱，按滑鼠右鍵→Rename Group即可。 
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相關章節 

相關本章節之詳細介紹，可參考英文手冊： 

 第八章之”Searching and Sorting in EndNote”章節。 

 建立群組與管理群組，可見第九章”Using Groups”章節。 
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第八章：從 EndNote 直接列印參考文獻 

本章節將引導您學習： 

 從EndNote中列印書目資料 

 

本手冊中，您可學到如何就所收錄的參考文獻進行列印、輸出，以分享書目資訊。  

開啟Sample Library 

如果還未執行 EndNote，請開啟 EndNote 程式，並開啟 Sample Library 檔案。 

查找參考文獻 

請依第七章查詢參考文獻之方式，找出您想要列印的書目文獻。本章同樣以上一

章的檢索策略為範例：查找有關extinction之2000年到2008年的參考書目。 

1. 就找到之4筆索結果書目，可點選作者欄位標題，依照作者姓名排序，經調整

後，可開始準備列印它們。 

 

預覽和列印找到的參考文獻 

列印出來所呈現之參考書目，可以依照您指定的書目格式進行呈現，故您在輸出

前，可先選擇一個輸出的Style，以便瀏覽。Style決定您參考文獻之列印、輸出、

預覽或建立書目時呈現之書目格式樣貌。 

預覽書目 
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1. 在主要工具列中，從輸出格式清單中選擇一個輸出格式。例如，本範例以選

擇Numbered格式為例。 

 

2. 從File選單→選擇Print Preview，先在您的電腦進行列印前的書目預覽。 

3. 您可以利用視窗頂端的按鈕功能預覽書目。 

4. 點選關閉即可關閉預覽功能。 

 

列印書目 

1. 同預覽書目之前置步驟；在主要工具列中，從輸出格式清單中選擇一個輸出

格式。如選擇Numbered格式。 

2. 從File選單→選擇Print，會出現一個列印對話視窗。 

3. 點選確定即可列印。 

 

儲存書目為文書處理檔案 

除了直接用列印書目清單的方式，您亦可另外將參考書目用檔案的方式輸出，分

享給其他使用者參考。而我們會建議可將輸出的檔案存成RTF檔案格式，因為一

般RTF檔案格式，可開啟在任何一Microsoft的文書處理器。 

 

1. 同樣的，請先選擇您欲書目資料呈現之輸出格式(Output Style)。本範例：以

選擇Author-Date格式為例。 
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2. 從File選單→選擇Export，將會出現另存新檔視窗。 

3. 選擇存檔路徑位置和輸入檔名。 

4. 在存檔類型的下拉選單中選擇Rich Text Format(*.rtf) 

5. 點選儲存，儲存檔案 

6. 您可利用任何文書處理器像Microsoft Word、WordPerfect等開啟RTF檔案。您

也可以在文書處理器中修改或是列印資料。 

 

相關章節 

相關本章節之介紹，可參考英文手冊： 

 第八章有更多關於查詢EndNote Library的資訊。 

 第十三章提供從EndNote Library直接建立參考文獻清單之說明。 

 第十六章提供更多關於修改和選擇格式說明。 
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第九章：在 Microsoft Word 中使用 EndNote 撰寫文章 

EndNote 的 Cite While You Write 功能內建在 Word2003 的「工具」選單中，以及

Word 2007 一 EndNote 的群組標籤。透過 Cite While You Write 的指令，可使

EndNote 於正在使用的 Microsoft Word 中，建立參考文獻的書目與引用格式。本

章節以 Microsoft Word 2003 或 2007 為範例，若使用不同文書處理器或版本，請

依英文手冊第十二章，或第十三章查閱如何引用 EndNote 參考書目至您的 Word

文件中。 

本章節您將學習到： 

 如何為投稿文章所撰寫之文獻建立起稿架構。 

 引用EndNote內的參考文獻，並建立參考書目。 

 引用資料但隱藏作者名稱和加上引用頁面之編輯。 

在 Manuscript Template 中建立新文件 

假如，您寫了一篇有關 Evolution 之論文，並欲投稿至 Nature 這本期刊，要撰

寫符合 Nature 該出版社發表文章之投稿格式；您即可透過 EndNote 中提供的

Manuscript Template 功能，能讓您更快速簡單地建立您發表論文之電子檔起草

架構、格式給出版社。詳細本單元之介紹，請參考英文手冊第十一章之”Using 

Predefined Manuscript Templates”。 

 

1. 從 EndNote 工具列 Tools 中選擇 Manuscript Templates。 

2. 出現 Manuscript Templates 視窗，選擇 Nature.dot 範本，點選開啟，來套用

Nature 撰寫文獻之範例架構。 
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注意： 

(1) 如果您是第一次使用 Manuscript Template Wizard，您會收到一個巨集

的安全性警告畫面。請選擇接受巨集，勾選”總是這個來源的巨集” → 

開啟巨集。 

 

 

(2) 如果您使用的是 Word 2007，您必須使用以下方式開啟巨集。 

點選”選項”。 
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點選”啟用這個內容”→”確定”，即會出現 EndNote Manuscript template wizard 視

窗。 

 
 
 



 

76 

3. 出現 EndNote Manuscript template wizard 視窗，點選下一步(Next)。 
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4. 輸入撰寫文章的篇名：”Theories About Evolution”，點選下一步(Next) 

 

5. 輸入該篇文章的作者姓名，首先選擇 Add Author 進行發表論文者的「作者

資訊」。在出現的視窗中點選 New，依序輸入作者姓名及相關資料，輸入完

點”確定”(OK)，您所輸入的作者會建立在 Author List 中，以同樣方式可再建

立第二位作者等其他作者資料。 

建立好所有作者資料後，按”確定”，再至上一層畫面選取這次發表文章的作

者，然後按”OK”，再點”下一步(Next)”。 
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6. 勾選這篇文章中所要呈現的資料，如正文、摘要、參考文獻、圖表等，選

擇完畢後點選下一步(Next)，之後點”完成”(Finish)。 

 

7. 點選完成後，系統會開啟 Word 檔案，以及剛剛所輸入的資訊和欲呈現的資

料(如下圖)，您即可開始編輯這篇文章。 
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引用 EndNote 中的參考文獻至 Word 

開啟一個 Microsoft Word 文件 

以下說明將以開啟一個 Microsoft Word 新的文件檔為例。 

開始撰寫您的論文和插入引文 

1. 輸入您欲撰寫的文章內容，例如： 

The fossil in question was generally regarded to be the 220 million year-old 
remains of tyrannosaurus. Several years ago, however, Morehouse overturned 
this hypothesis with the discovery of yet another species. 

現在，開始準備插入參考文獻（引用）。 

2. 從 Word2003 工具選單 → 選擇 EndNote X3 → 選擇 Find Citation(s)。 

 
 

 Word 2007 則是從 EndNote 標籤下使用各 EndNote 工具列的功能。 

發表論文者的基本資

訊、論文標題、摘要、

論文內容、研究方法

等，依版面指引您依

序撰寫文章內容。 
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3. 請點選「Find Citation」，接著跳出 EndNote Find Citations 視窗。在 Find 後的

空格中輸入作者名稱”Morehouse”，點選 Search，EndNote 會自動找出符合該

條件的參考文獻。利用視窗下方可確定該筆參考文獻是否符合您的需求。在

本範例中只有一筆資料符合。 

 
 

4. 確認無誤後點選該筆文獻，再點選 Insert 即可在文章內文中插入這筆文獻： 

EndNote 不只是插入引用文獻，也會就目前所選擇的 Numbered 書目格式，

產生在文章末端，做為您的參考書目。 

5. 在正文中加入欲增加書寫的內文： 
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It is now the undisputed progeny of the species at hand. 

6. 從 Word 2003「工具」選單 → 選擇 EndNote X3 → 選擇 Find Citation(s) 

注意：如果您使用的是 Word 2007 則是從 Endnote 標籤→Citation 群組中→點選

Insert Citation→再點選 Find Citation，即會跳出尋找文獻視窗(Find)。 

7. 在 Find 視窗的空白欄位中，輸入 1987 並點選 Search，EndNote 會自動找出符

合的參考文獻。 

 
 

8. 點作者為 Turnhouse 的參考文獻，再選 Insert： 

EndNote 會插入引用文獻，透過其 Cite While You Write 技術，將格式化您引

用的參考文獻為指定的書目格式，並加入該參考文獻在文章末端，呈現結果

如下圖所示： 
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9. 假設您已經完成在文章中插入引用文獻的步驟。從 Word 的檔案選單中→選

擇存檔；如果您使用的是 Word 2007：請點選”儲存檔案”，將文件儲存。 

注意：您也可以在註腳插入引用文獻。首先，經使用正確的 Word 指令進行註

腳， Word 會控制與分配註腳之數字；EndNote 會依照現有選擇的 Style 進行格

式化，是故，您採用的書目格式，要本身有包含註腳的書目格式，例如：Chicago 

15th A 格式之註腳功能才能作用。 

選擇書目格式 

凡有套用著 EndNote 參數的文件，您可以多次出版您的引用文獻和書目，改變

不同的輸出格式，並在其他版面編排設計格式。 

選擇要出版的書目格式 

1. 從 Word2003”工具”選單 → 選擇 EndNote X3 → 選擇 Format Bibliography 

 

 Word 2007 則是從 EndNote 標籤→Bibliography 群組→請點選 Bibliography 群
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組名稱旁的符號鈕。 

 
 

經點選後，會主動跳出一個 Format Bibliography 對話視窗，您可在此選擇書

目格式。Style 會影響引用與書目之格式。本範例，以 Numbered 格式做說明；

於其引文之處，會在文章之後對應同樣 Numbered 格式的參考文獻清單。 

 

同樣地，您也可以看到，在 With Output style 尚有許多其他出版格式選項，您可

改變不同的輸出格式，在 Word 即會一併覆蓋現行之輸出格式。 

2. 於上圖範例中，可點在 With output style 旁的”Browse”按鈕，呈現出所有

Output Style 清單。 

3. 選擇 APA 5th 格式，點選 OK。 

4. 在 Format Bibliography 對話視窗中點選確定。 

EndNote 將會自動將現有的引用文獻和書目重新產生為 APA 5th 格式。 

若您想改變輸出格式或是書目輸出版面設置，再一次選擇 Format Bibliography 指

其他書目格

式選擇 
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令即可。EndNote 會重新依您指定的格式，改變文中引用與新的書目格式。 

注意：目前 EndNote 已有超過 3700 個以上之 Style 格式。請在 EndNote 程式中從

Edit 選單→按鈕選擇 Output Styles →選 Open Style Manager，可看到所有格式清

單。您可自清單，點選”Get More on the Web”鈕下載更新各別的 Style，或以

EndNote 安裝程式點選完整的 styles 目錄進行安裝。 

 

編輯引用文獻 

如果您在編輯一個引用文獻或是書目，可以再次點選 Format Bibliography，去做

或修改所有引用文獻或書目的輸出格式，EndNote 即會依照選擇之輸出格式重新

出版。然而，對於個別引用文獻之更改，則是使用 Edit Citation 指令。 

對於一些書目格式，多數在引用上是以 Author 對應 Date 之格式呈現，但是若作

者的名字已經在文章段落中出現，則引用格式有的會規定無需重複出現作者名稱。

例如我們在文章該段落內容提及了 Morehouse 這位作者，則在這段落的文獻引

用上，作者名稱即該移除。另外，像我們可能對某些文獻引用在特定的頁面，則

您進行引用時，可能會希望顯示指定引用之頁碼。類似這種引用狀況之修改，可

善用下列步驟進行個別引用文獻編輯。 

 

編輯個別引用文獻 

1. 將滑鼠點選在 Morehouse 引用文獻上 
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2. 從 Word 工具選單→選擇 EndNote X3→選擇 Edit Citation 

注意：如果您使用的是 Word 2007 則是從 EndNote 標籤→Citation 群組→Edit 

Citation(s) 

 
 

 

3. 在 Formation Citation 中勾選 Exclude author。 

4. 在 Pages 中輸入 34-35。 

注意：在 Pages 框中輸入引用數字，應選擇 Citation Template 中有對應 Cited Pages
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的功能，該格式才具支援、確保頁碼會出現在引用之文獻。 

5. 點選 OK 更新 Word 中的引用狀況。 

 

 

插入引用圖表 

若您要在 Word 文件插入兩張引用圖表，一是圖片、一是表格。所有圖表引用文

獻插入方式都相同，故同樣選擇的書目格式決定是否具有插入圖表功能。 

找到和插入圖片引用文獻 

1. 首先在文章中對於欲插入的圖表做一說明，例如： 

As researchers look at evidence, even the crest on the modern cockatiel provides 
insight into the evolution of feathers. 

現在您可以準備插入圖表引用文獻 

2. 從 Word 2003”工具”選單→ EndNote X3 → Find Figure(s)，接著跳出 EndNote 

Find Figure 對話視窗。 

注意：於 Word 2007 則是從 EndNote 標籤→Citatin 群組→點選 Insert Citation→點

選 Find Figure。 

 

3. 跳出 EndNote Find Figure 尋找圖片的對話框；請在 Find 後方空白欄位中輸入

bird evolution，點選 Search。 
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4. EndNote 會自動列出符合的文獻並顯示圖片。 

5. 選擇 Caption 為 Bird Evolution 的文獻，點選 Insert。 

6. EndNote 會自動將該圖片插入到正在撰寫的 Word 檔案。 

 
 

找到和插入表格引用文獻 
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1. 首先在文章中對於您要插入的表格做一介紹，例如： 

While exploring the evolution of dinosaurs and birds, it becomes clear that Homo 
sapiens have occupied earth for a relatively short period of time. 

2. 從 Word2003 的”工具”選單→ EndNote X3 → Find Figure(s)，等待跳出 EndNote 

Find Figure 對話視窗 

注意：若使用 Word 2007，則是從 EndNote 標籤→Citatin 群組→點選 Insert 

Citation→點選 Find Figure（同插入圖片之步驟） 

3. 在 Find 後方空格中輸入 hominid，點選 Search。 

4. EndNote 會自動列出符合的文獻和圖表，在此找到的是 Excel 格式的圖表 

 

5. 確認要插入的參考文獻後，點選該筆參考文獻，之後點選 Insert，即可在文章

中插入該圖表(如下圖) 
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※ 從 Figure 和 Table 中可以看到剛才插入的圖表與 Excel 檔。 

※ 注意本範例是使用 Annotated 格式。此外，您可修改圖表大小。 
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※撰寫完論文請記得 Save 儲存檔案。您可繼續在論文中增加正文、引用書目、

引用圖片，EndNote 皆會繼續增加參考文獻、圖表、與表格清單。 

移除參數 

1. 文章完成後，從 Word 檔案 →儲存檔案，即可儲存該篇具有 EndNote 參數

文章。 

2. 如要移除參數，從 Word 2003 的”工具”選單→ EndNote X3 →Remove Field 

Codes 接著出現是否要儲存具有 EndNote 參數檔的對話框。 

注意：若使用 Word 2007，則是從 EndNote 標籤→Bibliography 群組→Convert 

Citations and Bibliography→Convert to Plain Text 

 

3. 儲存完畢後會跳出沒有 EndNote 參數的 Word 檔，即可另存新檔、移除完畢。 

相關章節 

本章節相關內容，請參考英文手冊： 

 若您想知道更多關於引用參考文獻、圖片和使用 Cite While You Write 建立參

考書目，請見英文手冊第十一章。 

 在EndNote Styles資料夾中，有超過3700個style；但在您所Typical安裝的

EndNote，會預設只出現100個最常被使用的styles。您可從EndNote中點選Edit 

→ Output Style → Open Style Manager看到style清單；詳細資訊請參考英文手

冊第十七章。 

 第十七章另有相關編輯書目格式之介紹。 
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第十章：在 OpenOffice.org Writer 使用 EndNote 撰寫文章 

本章將引導您如何在 OpenOffice.org 的文書處理軟體(version3)藉 Cite While You 

Write 功能進行文章撰寫、建立引用與書目格式。 

本章節您將學習到： 

 如何在OpenOffice.org引用參考書目，建立參考書目。 

 如何就參考書目修改書目格式(style)、輸出格式。 

文書處理軟體的相容性 

請注意欲運用 EndNote 進行文章的引用時，只支援第 3 版以上的 OpenOffice.org 

Writer。若您使用的是比較早期的 OpenOffice.org 版本，請先將您的文件儲存成

RTF 檔（詳細可參見英文手冊第十三章）。而當插入引用文獻與建立文件格式時，

一次只能開啟(用在)一個檔。經安裝完 EndNote X3 版本，理應在 OpenOffice.org 

Writer 會主動出現一個 EndNote X3 選單，若您是先安裝了 EndNote 後才再安裝

OpenOffice.org Writer，會無法直接支援、呈現 EndNote X3 功能選單，您需加以

Modify 您的 EndNote X3 或將 EndNote X3 移除，再重新安裝即可。有關安裝的詳

細資訊，請參考英文手冊第 697 頁的”No EndNote commands in Word or Writer”

單元說明。 

OpenOffice.org Writer 的 CWYW 指令列 

經在 OpenOffice.org Writer 成功安裝好 EndNote X3 後，會在 OpenOffice.org Writer

介面直接看到 EndNote X3 的 Cite While You Write 引用文獻的工具指令列。如下

圖所示。當您點了 EndNote X3 選單下的這 CWYW 任一功能，即會呼叫開啟

EndNote X3 管理軟體。 
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邊撰寫文章即邊引用EndNote參考文獻至OpenOffice.org Writer 

引用形式介紹 

這邊所指的引用(Citation)是指以圓括弧方式，就書目作者、年代資訊安插於您所

引用的文章段落。如下所示： 

 
……..of the species at hand1. 
 
……..of the species at hand (Argus, 1991). 
 

於您 OpenOffice.org Writer 文件中，可採用經套用格式化，或還未套用格式化的

EndNote 書目文獻。 

 

未格式化的引用文獻 

 

對引用文獻資料，當你點選”Unformat Citation(s)”或手動對資料設成 unformatted 

citations，會顯現文獻未經套用書目格式的未格式化狀態。 

未經套用引用格式的文獻，會暫時地指出引用文獻所在位置，包含這筆文獻在目

前您 EndNote Library 所對應的文獻是哪一筆，亦即第一位作者名稱的姓、文章出

版年代，以及 EndNote 系統對該筆文獻的紀錄號碼(示別碼)（其格式如下所示）；

EndNote 本身是靠這些未格式化的資訊來判別它是哪筆書目。這些資料在您文章

最後撰寫完畢輸出時，不會顯示出來。 

｛Author, Year #Record Number｝. 

例如： 

 {Alvarez, 1994 #8}  
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對於這種未格式化的引用文獻，其實可做為一種引用文獻的簡單識別，特別是假

設您最後使用數字型的引用格式，此時您即可將所有引用資料改成未格式化狀態，

這樣在撰寫文章時，反而有助您辨識所引用的文獻資料。 

 

格式化的引用文獻 

所謂的格式化，可指經指定套用在某一書目格式形式所輸出、呈現之格式狀態。

亦即，藉”Format Bibliography”指令來轉換所有未格式化的書目成一指定的格式，

並反應在最後輸出文章的呈現上。舉如採用 Author-Date 的書目格式，其引用格

式會是： 

(Alvarez 1994；Turnhouse 1987) 

同樣的這筆書目資料，若改成 Numbered 格式，則會變成： 

[1, 2] 
 

您可很簡單地對格式化的引用文獻與未格式化的引用文獻直接互相轉換。 

 尋找與插入引用文獻 

在 OpenOffice.org Writer 可以直接尋找 EndNote 的參考書目，並直接引用在文章

中，分別介紹如下： 

1. 打開您要引用文獻的那個 EndNote Library。 

2. 開啟 OpenOffice.org Writer 的文章，並將游標點在您要插入引用文獻的位置。  

3. 在 EndNote 選單中，點選”Find Citation(s)”，讓畫面跳出一個 EndNote Find 

Citations 的對話框視窗。 
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4. 請在 Find 空白欄位輸入您要找查文獻的界定詞彙，EndNote 會就您所輸入的

詞彙查找、比對全部文獻（任一欄位）。 

5. 請點選”Search”，EndNote 會將符合您條件的文獻查找出來，點選要插入的文

獻後，請選”Insert”，即引用在您文章指定之處。 

尋找與插入您所點選的文獻 

1. 另一個直接在文章上（不離開 OpenOffice.org Writer）引用文獻的方法，是就

在您撰寫的文章中，鍵入您要查找引用文獻的詞彙，並反白這詞彙。 

2. 至 EndNote 選單，點 Find Citation(s)選項，畫面即會直接跳出 EndNote Find 

Citations 的對話框視窗。 

3. 其餘的步驟，即同上述「尋找與插入引用文獻」的說明一致。 

插入您所點選的文獻 

1. 請開啟 OpenOffice.org Writer 文章，並將游標點在您要插入引用文獻的位置。  

2. 請點 EndNote 選單，並選”Go to EndNote”選項。 

3. 在 EndNote Library 點選您欲插入的引用文獻。 

4. 跳回畫面至 OpenOffice.org Writer 文章。 

5. 點 EndNote 選單，並選”Insert Selected Citation(s)”選項，即可插入引用文獻。 
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使用拖曳與複製－貼上來插入引用文獻 

您可自 EndNote Library 點選您要插入的文獻，直接拖曳到您 OpenOffice.org Writer

文章要引用文獻的插入位置。另外，您也可以在 EndNote Library 點選要引用的文

章，按複製後，回到 OpenOffice.org Writer 文章所要引用的位置，點貼上來插入

引用文獻（或在 EndNote 點 Edit 選單中的 COPY，然後回到 OpenOffice.org Writer

文章所要引用的位置，直接利用鍵盤按 Ctrl+V 貼上）。 

手動插入引用文獻 

若您不辭辛苦，亦可手動鍵入您所要引用的文獻；詳細關於如何鍵入之介紹，可

參考英文手冊第 380 頁之”Typing Citations into Your Paper”單元。 

插入同時多筆引用之文獻 

文章同一處同時引用多筆文獻，在格式化與未格式化的引用狀況，範例如下： 

未格式化呈現：{Hall, 1988 #77; Baker, 1988 #16} 

格式化的呈現：(Baker, 1988; Hall, 1988) 

 

透過 EndNote，在文章任一段落可同時引用數筆文獻，然而一次同時引用數百筆

參考書目，則有可能造成電腦突然變慢或甚至當掉，須注意一下大量引用之電腦

反應時間。 

 

在 OpenOffice.org Writer 同時插入數筆參考書目 

1. 自 EndNote 選單→Find Citation(s) 。 

2. 在查詢欄位輸入能讓您找到所要文獻的查詢詞彙→點 Search。 

3. 在查出列出來的參考文獻清單，按住 Ctrl 鍵，點選您要一起引用的數筆文獻

書目。若按 Shift，則可連續反白、選取書目。 

4. 點 Insert。 

 

自 EndNote 插入同時多筆引用的參考文獻 

1. 請將畫面點至 EndNote，按住 Ctrl 鍵，點選數筆您要一起引用的文獻書目；

或按 Shift 連續反白數筆選取書目。 

2. 回到 OpenOffice.org Writer 文章中。 

3. 點 EndNote 選單→Insert Selected Citation(s)。 

 

個別鍵入同時要引用的數筆文獻方式 
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另外您也可選擇自行個別鍵入您所要引用的多筆參考書目；只要您鍵入時，中間

沒有任何空格或標點符號（緊臨前一筆書目的格式），那麼 Cite While You Write

就能自動幫您將這些文獻整合成一起引用之格式。 

 

未格式化的樣式：{Hall, 1988 #77}{Baker, 1988 #16} 

當合併後的格式化樣式：(Baker, 1988;Hall, 1988) 

 

在已經有同時引用數筆文獻的同一段落，要新增或移除其中一筆參考書目 

1. 請在 OpenOffice.org Writer 文章中，點在被引用的書目上。 

2. 點 EndNote 選單→Edit Citation(s)→跳出 EndNote Edit Citation 對話框。 

 

在文章中所有引用的文章，會出現在對話框中的左邊欄位（區塊）。 

3. 點選您欲刪除的文獻（或插入文章的文獻位置處） 

 點 Remove 移除該筆文獻 

 點 Insert 然後選取您要新增加入的文獻在同一位置。 

 您可點選 Remove 右邊之兩個小的上下鍵按鈕，改變一起引用文獻的排

序位置。 

有關這編輯引用文獻的詳細介紹，可參考英文手冊第 377 頁。 

 

同時在不同的 Libraries 插入您要引用的文獻 
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我們可在數個不同的 EndNote Libraries 插入所要引用的文獻，但我們仍建議最好

文章都引用同一個 EndNote Library，引用的文章最好放在同一 Library 底下；這樣

才能方便您撰寫文章，明確知道哪筆參考文獻可在哪裡找到、減少多餘複本；而

且您引用文章時，也只需開啟一個 Library 就好。 

個別設定引用文獻(Customizing Individual Citations) 

依不同的書目格式規定，會有對引用格式做個別調整的需求，例如在文章之同一

句或段落已有出現作者或年代字眼；依照有些書目格式規定，這種引用文獻的作

者就不需出現作者名稱，或將年份移除。另外，您可針對引用出處指定頁碼，或

在該引用文獻的前後加入註解。例如：針對原本引用格式，會另有以下個別狀況： 

 

 原本引用格式： 

Hall’s discovery (Hall, 1988) 
 

 不需出現作者名稱的狀況： 

Hall’s discovery (1988) 
 

 不需出現年份的狀況： 

the 1988 discovery (Hall) 
 

 在引用文獻的格式之後加上頁碼（指定參考出處）： 

the discovery (Hall, 1988 p.4) 
 

 在引用格式之前加上註解字眼： 

the discovery (see Hall, 1988) 
 

要個別設定修改引用格式 

1. 插入和格式該引用文獻。 

2. 點一下引用的這篇文獻。 

3. 在 OpenOffice.org Writer 點 EndNote 選單→Edit Citation(s)→跳出 EndNote Edit 

Citation 對話框視窗。 
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在文章中所有引用文章，會出現在對話框中的左邊欄位（區塊）。 

4. 點選您要編輯、個別修改的引用文獻。 

5. 在對話框右邊區塊，可看到能個別修改之客製化功能有： 

 移除作者名稱：鉤選 Exclude Author，剔除所點選文獻之作者名稱。 

 移除年份：鉤選 Exclude year，就會剔除所點引用文獻的年份。 

 Prefix：在此空白欄位中，可在引用文獻的格式前加入您所要加註的詞

彙（並建議在詞彙後加入一個空格）。 

 Suffix：在此空白欄位中，可在引用文獻的格式後加入您所要加的詞彙

（例如”頁碼”，建議在詞彙前亦加一個空格）。 

 Pages：您可就指定的引用頁面，註明引用出處頁碼，並呈現之。但要

列印出來時，必須本身書目格式在引用樣式或註腳樣式有 Cited Pages

欄位；例如這種有頁碼的，一般只能套用在有支援與註解這樣引用的幾

個格式上，詳細可進一步參考第十七章之”Cited Pages”單元。 

6. 請點 OK 來看調整結果。 

在已格式化的文章插入引用文獻 

若您需新增一筆參考文獻在已引用某書目格式的文章中（如本章先前介紹），可

加入一筆新的參考文獻，並點 Format Bibliography 更新書目與引用狀況。 

若是新增一筆書目在已有引用文章的地方，可在該引用文獻之隔壁插入，例如：
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(Hockney and Ellis, 1996){Argus, 1984 #1} 

相臨的第二篇文獻即會被 EndNote 依同樣書目格式合併，並排序在一起。例如變

成：(Argus, 1984; Hockney and Ellis, 1996) 

注意：不要點在引用文獻格式的中央進行插入文獻動作，請點在該引用文獻格式

之前或後，中間不要有任何空格。 

 

在註腳插入引用的參考書目 

在 OpenOffice.org Writer 中的註腳(footnote)或註釋(endnote)，插入引用的參考文

獻，其做法跟在文章內文中的引用方式一樣： 

1. 在 OpenOffice.org Writer 中先插入好註腳或註釋。 

2. 將游標移至您要引用 EndNote 文獻的註腳（或註釋）位置。 

3. 插入參考書目。 

 

EndNote 可就註腳（註釋）這些引用書目提供簡易或完整版的引用格式，也能針

對這些註腳（註釋）指定特定格式（像 Ibid.）。詳細請參見第十七章”Bibliography 

and Footnote Templates”第 480 頁。 

 

改變既有之引用文獻 

您可隨時編修您所要引用的文獻書目，並透過 Format Bibliography 改變引用書目

格式、更新參考文獻。 

編輯引用文獻 

一旦您引用了文獻，並套用在某一書目格式後，請不要直接在文件中更改引用狀

況，因一經直接修改可能會造成該書目呈現之格式不正確。 

 

正確安全地編輯引用文獻 

1. 請點選您想要更改的文獻。 

2. 於 OpenOffice.org Writer 點 EndNote 選單→Edit Citation(s)→跳出 EndNote Edit 

Citation 對話框。 
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在文章中所有引用的文章，會出現在對話框中的左邊欄位（區塊）。 

 

3. 請在左邊欄位區塊，確認點到您所要修改的該筆文獻後，再分別依下列功能

在右邊區塊進行編輯： 

 移除作者名稱：鉤選 Exclude Author，剔除所點引用文獻的作者名稱。 

 移除年份：鉤選 Exclude year，剔除所點引用文獻的年份。 

 Prefix：在空白欄位中，輸入您欲在引用文獻前加註之詞彙（建議在詞

彙後加一個空格）。 

 Suffix：在空白欄位中，輸入您欲在引用文獻格式後加入註解之詞彙（建

議在詞彙前亦加一個空格）。 

 Pages：您可就指定引用的頁面，註明引用頁碼。 

4. 您可點 add 加入多筆引用文獻或 remove 移除某筆文獻。 

5. 若您還未限定引用文獻的排序方式，亦可同時引用多筆文獻之處，以上下鍵

“ ”變更引用文獻的排序位置。 

6. 請點 OK 來看調整結果。 

 

轉成未格式化的引用格式 

透過 EndNote 可將已套用某一書目格式的引用書目轉回未格式化狀態，並移除書
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目資料。特別是採用數字型的書目格式，可先設成未格式化的狀態，以便您在撰

寫的文件中區辨，最後再整個轉成數字型書目格式(Numbered Style)。 

1. 先決定哪些引用書目您想要轉成未格式化： 

 反白該筆引用書目。 

 若是同時引用數筆書目的狀況，但只要轉其中一筆；也請選取該處多

重引用的所有書目為反白。 

 若是要轉文件中的部份章節，只要選擇那個章節。 

 若是要轉整份文件的所有引用書目，即無須做任何選取。 

2. 至 EndNote 選單→Unformat Citation(s) 

經轉整份文件所有引用書目去格式化後，那麼現有之書目也會一併移除。 

 

在文章中，若出現{Smith, 1999 #25}之引用格式，則表示您文章的引用書目目前

在未格式化的狀態。但未格式化的這些引用書目最後並沒辦法呈現在輸出上，所

以您可以再選擇任一書目格式，進行引用書目的格式化。若欲格式化成某一書目

格式，請點 EndNote 選單，並選擇 Format Bibliography。 

 

移動或複製引用文獻 

您可自文件中，任何複製含有引用書目的文句段落，並貼在文件中任何地方。請

在移動或要複製引用文獻時，確認您有完整選取了該篇引用文獻（含定義符號），

亦即包含該引用文獻前後的隱藏書籤(bookmark)；否則，您將只是複製表面文字，

而不是 EndNote 的引用文獻；接著，請就文件任一位置點選複製、貼上即可。 

刪除引用文獻 

若您採用未格式化的引用文獻，可直接選取欲刪除的引用文獻（含定義符號），

並按 delete 鍵或 Backspace 刪除。 

但若您已經套用某一書目格式之引用狀態，像上述步驟直接選取、刪除（按 delete

鍵等）會無法真正移除所引用文獻以及其隱藏的書籤，而致您文件引用文獻顯示

已刪除，可是對應它的參考書目還是在而走樣的狀況。 

 

正確安全地刪除格式化的引用文獻 

1. 在 OpenOffice.org Writer 文件中點選您欲刪除之引用文獻。 

2. 點 EndNote 選單→Edit Citation(s)→跳出呈現之 EndNote Edit Citation 對話框視

窗。 
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3. 在對話框視窗左邊的區塊，點選您欲刪除的引用文獻。 

4. 點 Remove→OK. 

 

產生書目清單 

格式化您的參考書目有兩種作用： 

 藉格式化來統一一致文件的所有書目格式。 

 對應文中所引用書目，產生一份書目清單（參考文獻）。 

格式化書目與改變書目格式 

不論您是否已經完成了文章撰寫與引用狀況，只要文章中有引用書目，即可進行

書目格式化作用。若再加入了任何新的引用文獻，也能再格式化或改變書目格式、

設定輸出。 

1. 在 OpenOffice.org Writer 文件中，點 EndNote 選單→Format Bibliography→跳

出 Format Bibliography 對話框。 

2. 在 Format Bibliography 頁面標籤下，選擇您欲輸出的書目格式或相關設定： 

 
 

 With output style：選擇適當的輸出格式來格式化您的參考書目。可重複點選

不同書目格式，來展現不同格式之呈現結果。詳可參考英文手冊第 339

頁”Adding Styles to the Output Styles List”單元。 

 Temporary citation delimiters：於暫存的引用文獻有個起迄定義符號，請注意

它是一個定義符號（蜷曲的大括號），而不是只是文件中一個單純的文元符
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號。 

3. 在 Layout 頁面標籤下，相關設定如下： 

 
 

 Font and Size：書目字型與大小之設定。 

 Bibliography title：若您想在您的參考書目上面列個標題，即可在此設定，例

如“References”、”Reference List” 

 Text Format：反白、選取參考書目的標題→Text Format 鈕→跳出對話框視窗

→更改您欲呈現之參考書目標題字型、大小。 

 
 

 Start with bibliography number：輸入您參考文獻的開始編號。 

4. 點 OK 儲存變更，並格式化您指定之書目格式與引用文獻。 

 

再格式化您的文件 

增加新的引用文獻至您已格式化過的文件 

經格式化過您的文件後，又再新增引用文獻，可直接在 Format Bibliography
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重複上述套用某一輸出格式方式：EndNote 選單→Fomrat Bibliography → 

OK.，重新更新您的書目格式即可。 

從不同的文件建立書目清單 

可透過 OpenOffice.org Writer 的 Master Document 功能，自不用的文件整合成一

份參考書目清單；並且可就於圖書這種具各章節之書目累計於一起。 

 

建立一份參考書目清單 

1. 在不同的文件，或章節插入您引用的文獻，並確認這些書目與 EndNote Library

為串連狀態。 

2. 在各篇文件中，點 EndNote 選單，點選 Unformat Citations 先去格式化所有引

用書目。 

3. 關閉所有文件。 

4. 在 OpenOffice.org Writer 開啟一份新的 Master Document：File>New>Master 

document。 

5. 插入您每一章節內容，就好像一份子文件一樣（若需 step-by-step 的指引，請

點選 OpenOffice.org Writer help documentation。 

6. 點 EndNote 選單→Format Bibliography。 

7. 變更格式選項→OK。 

 

編輯書目 

在撰寫文章的過程，請確保您所引用之文獻在 EndNote Library 編輯過後，有在撰

寫的文章中自動校正、正確呈現。所謂之編輯，包括編輯您所引用的書目、新增

與刪除內容等狀況。記得最後要再更新一次您文件中的書目格式，以確保修正文

件中引用書目。 

 

因為 EndNote 在編輯過後，並無法確保您有引用到的文獻能自動就您所再編輯過

的內容自動訂正於文件引用上。所以，還是有必要請自行手動編輯這些格式化的

書目。亦即，您可直接就您對某筆引用文獻所編輯的內容，也在文件中引用的該

筆文獻做直接訂正；待訂正後，一經重做一次書目格式化，原本待更正的書目內

容即會不見，轉換成正確、對應 EndNote Library 編輯結果的該筆書目。 

 

請參考第十七章“Styles”章節，看到有關編輯書目之詳細介紹。 
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移動書目 

一般 Cite While You Write 是在 OpenOffice.org Writer 的文件中，置底呈現書目（這

也是我們比較建議的書目呈現模式）。但若有其他並不能置底的特殊情況，您可

依照下列方式移動、調整書目位置。 

 

在書目之後新增文字的情況 

若須在書目之後新增文字，請您確認您是在整個書目位置範圍之後，即可加入文

字。但若您不小心加在書目位置的範圍內，則這些文字經您重新格式化了書目即

會被清除、不見。 

複製、貼上書目 

於複製和貼上書目之處理比較煩瑣，第一：先選取整個書目（但請確定清楚是在

開始的第一筆書目前(或參考書目標題前)的兩個段落。第二：加入完整的書目，

在書目之後再加入一個段落（Enter 一個空行）。第三：剪下原本舊的書目，再貼

至新的書目位罝上（覆蓋上去）。 

清除書目 

欲刪除書目時，請點選書目，然後按 delete。 

請確定您是在整份書目的上面一行，按著滑鼠進行拖選到書目底端的動作，選了

整份書目；欲清除時，可直接按 Backspace 或 Delete；另也可選剪下(cut)書目，

到您想貼上的任何一個地方。 

進行 Cite While You Write 的喜好設定 

在 OpenOffice.org Writer 選 EndNote 選單→Cite While You Write Preferences。 
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 Open EndNote When Starting OpenOffice.org Writer 

勾選這個選項，在 OpenOffice.org Writer 永遠打開 EndNote 工具列。 

 Close EndNote When leaving OpenOffice.org Writer 

 勾選這個選項，在您關閉 OpenOffice.org Writer 後，永遠關閉 EndNote 工具

列。待在 OpenOffice.org Writer 中啟動了一個 Cite While You Write 指令或經

重新鉤選掉這個喜好設定，則 Cite While You Write 工具列才又會開始啟動。 

此相關說明可參照第 594 頁的”Temporary Citations”單元或第 600 頁的”Formatting”

單元。 

 

經改變之處對應 EndNote Library 

一旦您在 OpenOffice.org Writer 所插入或格式的引用文獻，在經重新格式化書目

後，能同時對應到 EndNote Library。 

在 EndNote Library 編輯一筆參考書目 

您可能在先 OpenOffice.org Writer 已先插入了某文獻，然後才又再到 EndNote 另

編輯這筆參考書目，這樣經您文章下次再重新格式化一次書目後（EndNote Library

要同時開啟的狀態），就能反應您原先編輯過的內容到文件中。但若您重新格式

化一次書目時，EndNote Library 沒有同時在開啟的狀態，這樣就不能透過 EndNote

反應您原本更新了的書目內容於文件去。 
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在 EndNote Library 刪除一筆參考書目 

在您首次引用文獻時，EndNote 是透過每筆書目未格式化的訊息對應到打開的

EndNote Library；經您做了一次書目格式化的套用後，EndNote 會重新再讀一次

格式化後的資訊，並再對應一次到 Library 的書目裡去。 

若您自 EndNote Library 刪掉了有引用的那筆參考書目，EndNote 則沒辦法循文件

引用的書目資訊到 Library 底下找到對應的那筆書目資料。既使您再重新自

EndNote Library 建入那筆書目，這筆書目也會被給予另新的 EndNote 系統紀錄碼；

故對於您有刪除的參考書目，請您需重新插入、引用到文件來。 

 

EndNote 系統紀錄碼 

EndNote 對每筆書目給予一單一的識別碼，在未格式化的書目格式狀態即會看到，

其樣式如下： 

{Argus, 1991 #11} 

您並可以在每筆書目之 EndNote 參考書目視窗標題列上，看到其顯示的系統紀錄

碼。 

故請記得： 

當您新增一筆書目至 EndNote Library，EndNote 會給予其一獨立以供識別的系統

紀錄碼；這些碼是系統提供的，所以使用者也無法修改。 

若同樣的參考書目內容出現在不同的 Library，系統產生之記錄碼也幾乎不同 (註：

因前作者名稱與年份會一樣)。特別是，這些碼在同個 Library 底下絕對不會重複，

即使您刪掉了原本所鍵的那筆書目，也不會再重新給同樣的紀錄碼。 

也因應這樣的系統給號模式，我們不太可能會記得住所有書目的紀錄碼為何，是

故建議若您有在 Library 刪掉了某筆書目，在文件上請您再重新進行引用的動作，

以確定套用在文件上的引用文獻能正確呈現。 

 

分享您 OpenOffice.org Writer 的文件 

當您想要自舊版的 Writer 或不同的文書處理軟體轉出您的文件，在儲存不同檔

案格式時，請先將引用的文獻轉成未格式化的格式，以利之後能再進行書目格式

化。 

在不同的電腦撰寫文章時 

若您是同一份文章，但在兩台電腦之間進行陸續撰寫，則請您需複製一份

EndNote 的該參考書目 Library 檔，以跟著您的文件進行文獻套用。也就是請您務
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必確保您在 EndNote Library 所編輯的內容與您撰寫的文件一致，所以像在家的那

個 EndNote Library 檔引用了一筆參考書目，然後公司在用的那個 EndNote 

Library(copy 版)卻沒有新增那筆，則在公司的 EndNote 即沒辦法正確顯示所對應

後來文件有新增的該筆引用書目。 

 

當您原只是在一台電腦處理引用文獻，只要您是使用同一版本的 Writer，亦可移

動文件到另外一台電腦去；只是當您那台電腦沒有灌 EndNote 或 EndNote Library

無法正常開啟時，會無法在 OpenOffice.org Writer 進行進行書目格式化。  

儲存檔案至不同版本的 Writer 或文書處理軟體 

請注意的是，當您在不同版本的 Writer 打開您的文件，或使用另存新檔(Save As)

將您的文件儲存成另外的檔案格式，則原本套用在文件的 EndNote 格式會無法呈

現。 

所以，在要以不同的文書處理軟體開啟您的文件、使用不同版本的 OpenOffice.org 

Writer、或在 Macintosh 系統處理，請您先將文件上引用的文獻進行未格式化

(Unformat Citations)，再存成不同的檔案格式。但注意的事，未格式化的書目格

式，其實只是文件上的純文字記錄，並不會反應在最後的輸出上。其他相關之未

格式化的介紹，可參考第 382 頁之”Unformatting Citations”單元。 

在 Microsoft Word 與 Writer 移動文件 

於您套用了 EndNote 引用文獻的文件檔，可在 Microsoft Word 與 OpenOffice.org 

Writer 間互用。 

請記得在原本處理的文書軟體中，先將您的文件去格式化，並存檔；待至另一套

文書處理軟體打開此檔前，先確認該文書處理軟體已支援 EndNote 書目管理軟體，

即可打開後，再格式您文件中的引用狀況和書目資料。 

 

下列幾項功能只有在 Microsoft Word 可以使用，目前尚未支援 OpenOffice.org 

Writer，分別是： 

 使用手稿範本(template wizard)。 

 插入註解。 

 插入圖表(figures/tables)。 

 未支援不斷背景的立即格式化。 

 未能在同一份文件以章節的形式建立數份書目。 

 未支援 Library 移動(traveling library) 
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相關章節 

 有關在OpenOffice.org Writer的Cite While You Write介紹，可參見英文手冊第

十二章。 
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第十一章： 建立一個主題書目 

 在這個單元，將教您如何利用各欄位建立和列印一個參考書目群組。 

開啟 Sample Library 

請先執行 EndNote（開啟 EndNote 程式），並開啟 Sample Library 檔案。 

選擇參考書目範圍 

1. 從您開啟的 EndNote Library 中，進行匯編參考文獻清單的動作 

2. 可限定查詢清單中的參考文獻，或只顯現選擇之參考文獻。本範例以選擇包

含所有在 Library 中的參考文獻進行說明。 

3. 確定所有的參考文獻都有顯現：從 EndNote → Reference → Show all Reference。

如果 Show all Reference 呈現無法選取，則表示 EndNote Library 已經呈現所有

參考文獻了 

選擇主題欄位和詞彙 

1. 從 EndNote Library → Tools → Subject Bibliography → 呈現 EndNote Library 中

的主題欄位。 

2. 將 Keyword 選取、反白。 

可依主題欄位進行單一欄位或數個欄位選取；通常多選擇由關鍵詞欄位來進

行主題書目之建立。 
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3. 點選 OK，顯示利用關鍵字欄位所找到的詞彙。 

4. 接下來會出現 Subject Terms 對話框。可選擇任何您想點選之詞彙；本例，我

們選擇所有關鍵字，以 Select all 為例。 

 

 

5. 點選 OK，採用關鍵字進行分析之主題書目即呈現在螢幕上。 
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改變書目輸出格式 

1. 您可以在主題書目畫面上面的 Output Style 下拉選單，選擇不同輸出格式（本

例正套用在 Numbered 格式上）。例如，選擇 Author-Date，主題書目將會更

新成 Author-Date 新格式。您也可點 Select Another Style，以選擇其他 3700

多筆不同之輸出格式。 

2. 點 Output Style 旁的”Layout”按鈕，即可修改輸出格式與主題書目格式。 

3. 在 Reference 項目中，可改變 Reference List Title 為 Reference，或其他希望列

印時，書目上出現之標題；另外，也可改變每筆參考書目在呈現上的排序方

式。 

關鍵字 

關鍵字文獻數量 
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4. 在 Terms 項目中，可分別設定 

（1） Reference List 

您可選擇 Subject Terms Only，只呈現主題標題、不呈現參考文獻之格式。選

擇 Subject Terms and Reference List，一起呈現主題標題與參考文獻。本範例，

選擇 Subject Terms and Reference List 和 Recycle Numbering 為例；經勾選

Recycle Numbering，當您採用數字型的書目格式時，即可看到其上各關鍵詞

彙下所列之參考書目編號採用續號的方式呈現。 
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（2） Include 

在此項目中，您可勾選 Subject Term Counts 呈現主題詞彙的數量，或勾

選呈現每筆書目的系統紀錄碼。 

（3） Subject Term Layout 和 Styles：主題詞彙輸出排序和字體樣式。 

5. 請注意的是，在 Bibliography Layout 項目中，若採用 Author-Date 輸出格式，

其選定的起迄欄位，在呈現參考文獻上會沒有嵌入空格，而接連著參考書目

內容。於 Hanging Indent 指每筆參考書目，是否要做版面編縮的呈現。 

6. 選確定，儲存改變設定。 

7. 在主題書目中我們還可使用的功能如下。 

（1） Print Preview：您可以預覽主題書目列印的樣式。 

（2） Print：列印主題書目。 

（3） Save：儲存主題書目，並選擇您想要的儲存格式 text、rtf、html。 

8. 點選 Close 來關閉主題書目視窗，回到 EndNote Library 中。 
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相關章節 

 請見英文手冊第十五章提供更多主題書目與主題清單之介紹 

 


